Disclaimer of Warranties and Liability

The information contained in this manual is believed to be accurate and reliable. However, GE Intelligent Platforms, Inc. assumes no responsibilities for any errors, omissions or inaccuracies whatsoever. Without limiting the foregoing, GE Intelligent Platforms, Inc. disclaims any and all warranties, expressed or implied, including the warranty of merchantability and fitness for a particular purpose, with respect to the information contained in this manual and the equipment or software described herein. The entire risk as to the quality and performance of such information, equipment and software, is upon the buyer or user. GE Intelligent Platforms, Inc. shall not be liable for any damages, including special or consequential damages, arising out of the user of such information, equipment and software, even if GE Intelligent Platforms, Inc. has been advised in advance of the possibility of such damages. The user of the information contained in the manual and the software described herein is subject to the GE Intelligent Platforms, Inc. standard license agreement, which must be executed by the buyer or user before the use of such information, equipment or software.

Notice

©2012 GE Intelligent Platforms, Inc. All rights reserved. *Trademark of GE Intelligent Platforms, Inc.
Microsoft® is a registered trademark of Microsoft Corporation, in the United States and/or other countries.
All other brands or names are property of their respective holders.

We want to hear from you. If you have comments, questions, or suggestions about our documentation, send them to the following email address:

doc@ge.com
# Table of Contents

About This Guide ..............................................................................................................................1  
Reference Documents .....................................................................................................................1  
Using Charts to Analyze Process Trends .....................................................................................3  
What is a Chart? ...........................................................................................................................3  
Types of Charts ..........................................................................................................................3  
Adding Charts to Your Pictures ..................................................................................................4  
Comparing Standard Charts and Enhanced Charts .................................................................4  
Plotting Different Types of Data ................................................................................................6  
Displaying SQL Data ...................................................................................................................7  
Working with Enhanced Charts ..................................................................................................9  
Enhanced Chart Types ...............................................................................................................9  
Statistical Process Control Charts ............................................................................................9  
Other Types of Enhanced Charts ...........................................................................................12  
Working with Enhanced Chart Properties ..............................................................................17  
Applying Enhanced Chart Properties .....................................................................................18  
Naming an Enhanced Chart .......................................................................................................19  
Entering an Enhanced Chart Description ................................................................................19  
Defining Data Sources for Enhanced Charts ............................................................................19  
Understanding Enhanced Chart Data Source Limits Symbols ..............................................23  
Scrolling an Enhanced Chart ....................................................................................................25  
Changing the Appearance of an Enhanced Chart ....................................................................28  
Adding a Title to an Enhanced Chart ......................................................................................28  
Changing the Chart Update Rate for an Enhanced Chart ......................................................28  
Understanding Refresh Rates for Enhanced Charts ..............................................................29  
Configuring the Legends for an Enhanced Chart ....................................................................29  
Choosing a Border Style for an Enhanced Chart ...................................................................30
Trending Historical Data

Choosing the Format and Precision of Data to Display for Enhanced Charts .....................30
Defining a Grid for an Enhanced Chart .............................................................................30
Defining Time Ranges for an Enhanced Chart ..................................................................30
Configuring the X and Y Axis for an Enhanced Chart .......................................................31
Choosing Fonts for Enhanced Charts .............................................................................31
Changing the Color Scheme of an Enhanced Chart .........................................................33
Defining the Plotting Style for Enhanced Charts .............................................................36
Working in the Run-time Environment for Enhanced Charts .............................................36
Defining Run-time Attributes for an Enhanced Chart ........................................................36
Zooming in an Enhanced Chart ........................................................................................37
Displaying Time Cursors in an Enhanced Chart ...............................................................37
Displaying Hover Tool Tips in an Enhanced Chart ............................................................38
Displaying Data Point Labels in an XY Chart .................................................................40
Understanding Chart Time for Enhanced Charts .............................................................42
Adjusting for Daylight Savings Time for Enhanced Charts .............................................43
Choosing Subsets for Line/Multiline Graphs ....................................................................43
Marking Data Points in an Enhanced Chart .......................................................................44
Performance Considerations and Limitations for Enhanced Charts ..................................44
Exporting Data from an Enhanced Chart ........................................................................44
Working with Standard Charts .......................................................................................45
Working with Standard Chart Properties ........................................................................45
Applying Standard Chart Properties ..............................................................................45
Defining the Pen Type ......................................................................................................46
Defining General Standard Chart Properties .....................................................................50
Naming a Standard Chart ..............................................................................................50
Entering a Standard Chart Description ............................................................................51
Attributing a Help Context ID ..........................................................................................51
Scrolling a Standard Chart .............................................................................................51
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Changing the Appearance of a Standard Chart</td>
<td>53</td>
</tr>
<tr>
<td>Changing a Standard Chart's Foreground or Background Colors</td>
<td>54</td>
</tr>
<tr>
<td>Changing the Refresh Rate</td>
<td>55</td>
</tr>
<tr>
<td>Defining Pen Styles</td>
<td>55</td>
</tr>
<tr>
<td>Defining Time Ranges</td>
<td>56</td>
</tr>
<tr>
<td>Configuring the X and Y Axis</td>
<td>59</td>
</tr>
<tr>
<td>Defining a Grid</td>
<td>60</td>
</tr>
<tr>
<td>Configuring the Legend</td>
<td>61</td>
</tr>
<tr>
<td>Animating Chart Properties</td>
<td>61</td>
</tr>
<tr>
<td>Working in the Run-time Environment</td>
<td>61</td>
</tr>
<tr>
<td>Defining Run-time Attributes</td>
<td>62</td>
</tr>
<tr>
<td>Zooming</td>
<td>62</td>
</tr>
<tr>
<td>Displaying Multiple Values and Times</td>
<td>63</td>
</tr>
<tr>
<td>Displaying Time Cursors and Tool Tips</td>
<td>64</td>
</tr>
<tr>
<td>Understanding Standard Chart Time</td>
<td>65</td>
</tr>
<tr>
<td>Adjusting for Daylight Saving Time</td>
<td>67</td>
</tr>
<tr>
<td>Using the Chart Group Wizard with Standard Charts</td>
<td>69</td>
</tr>
<tr>
<td>Displaying and Using the Chart Group Toolbar</td>
<td>69</td>
</tr>
<tr>
<td>Before You Begin Working with the Chart Group Wizard</td>
<td>70</td>
</tr>
<tr>
<td>Understanding Charts and Pens</td>
<td>71</td>
</tr>
<tr>
<td>Understanding Chart Group Files</td>
<td>71</td>
</tr>
<tr>
<td>Analyzing the Demonstration Picture</td>
<td>71</td>
</tr>
<tr>
<td>Defining Pens in a Chart Group File</td>
<td>72</td>
</tr>
<tr>
<td>Adding, Modifying, Deleting, and Re-Ordering Pens</td>
<td>73</td>
</tr>
<tr>
<td>Setting Pen Styles</td>
<td>74</td>
</tr>
<tr>
<td>Setting Pen Properties</td>
<td>74</td>
</tr>
<tr>
<td>Historical Mode Options</td>
<td>76</td>
</tr>
<tr>
<td>Applying Changed Pen Configurations to a Chart</td>
<td>77</td>
</tr>
<tr>
<td>Topic</td>
<td>Page</td>
</tr>
<tr>
<td>------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Defining Pens</td>
<td>104</td>
</tr>
<tr>
<td>Using Scripts with the Chart Group Wizard</td>
<td>105</td>
</tr>
</tbody>
</table>
About This Guide

The Trending Historical Data manual is intended for process control engineers and operators who are responsible for analyzing real-time and historical data using iFIX®. The manual assumes knowledge of the Microsoft Windows environment, and basic iFIX operations and concepts.

Reference Documents

For related information on iFIX, refer to the following manuals:

- Building a SCADA System
- Understanding iFIX
- Setting Up the Environment
- Creating Pictures
Using Charts to Analyze Process Trends

Given the vast amount of data you can collect with iFIX, you need a way to present the information and react to the results. Once you have collected the necessary data, you can display the data as process trends in a chart. iFIX charts let you plot both real-time and historical data on the same chart, and gives you easier access to the information you need.

Refer to the following sections for more information on charts:

- What is a Chart?
- Comparing Standard Charts and Enhanced Charts
- Plotting Different Types of Data
- Displaying SQL Data

What is a Chart?

Charts are an effective way to display trend data to users. They enable you to view specific sets of data relative to other data, thereby allowing you to continually determine the status of your process.

Charts are objects, and as such contain properties, methods, and events, just like any other iFIX object that you can add to your picture. This means you can animate a chart through VBA, or change the chart's colors or other properties. The behavior of iFIX objects is fully documented in the Creating Pictures manual. The VBA properties, methods, and events are documented in the iFIX Automation Reference manual.

iFIX offers many types of charts for displaying your trend data. They are divided into two groups: Enhanced Charts and Standard Charts. Enhanced Charts include many types of statistical process charts and are highly customizable. Standard Charts allow you to configure an unlimited number of data sources, in any combination, for your chart. For more information about each type of chart, refer to the Types of Charts section.

Types of Charts

iFIX provides two types of charts for displaying trend data. The two types of charts are Enhanced Charts and Standard Charts.

Enhanced Charts

Beginning with iFIX 5.0, Enhanced Charts are available in addition to the Standard Charts always available with iFIX. Enhanced Charts include the following types of charts:

- Line/MultiLine Chart: displays the trend of a variable(s) over time. In this chart, the X-Axis always represents the time. Both real time and historical data will be allowed to co-exist within the same Enhanced Chart. You can plot an unlimited number of data sources, in any combination or type. Any database block is allowed.

- SPC - X-Bar Chart: displays the real-time average value (X-Bar) from a Statistical Data (SD)
Trending Historical Data

database block.

- SPC - R-Bar Chart: displays the real-time average range (R-Bar) from a Statistical Data (SD) database block.
- SPC - S-Bar Chart: displays the real-time average standard deviation (S-Bar) from a Statistical Data (SD) database block.
- Histogram Chart: displays a frequency distribution. The data for the Histogram Chart comes from the Histogram (HS) database block.
- XY Chart: displays the relationship between two DataSets. The data can either be real-time or historical in nature. However, only one type of data can exist in the same Enhanced Chart. Any database block, except SD, HS, ETR, SQT, SQD, or PA is allowed.

Enhanced Charts are highly customizable; you can customize every aspect of a chart's appearance, from the color theme to the font used for the title. For more information on customizing Enhanced Charts, refer to Working with Enhanced Charts.

Additionally, unlike with Standard Charts, with Enhanced Charts, you can export the data being viewed in the chart. You can export in a variety of graphical and text/data formats to the Windows clipboard, a printer, or a file.

Standard Charts

iFIX Standard Charts are multi-pen, meaning that they allow you to configure multiple pens in one chart. Multi-pen charts can plot an unlimited number of data sources, in any combination. There is no limit to the number of pens you can add to your picture, you are only limited by the memory in your system. You can set up each trend line with a different color and marker style, and different time ranges. For more information on customizing Standard Charts, refer to Working with Standard Charts.

Adding Charts to Your Pictures

To add a chart to your picture, click the Chart button on the Shapes toolbar (Classic view) or on the Insert tab, in the Charts group, click the desired chart style (Ribbon view - pictured in the following figure). If the Toolbox is enabled, click the button on the Toolbox.

![Chart Selection Options - Ribbon View](image)

Comparing Standard Charts and Enhanced Charts

The following table details the features that are provided by Standard or Enhanced Charts.
### Using Charts to Analyze Process Trends

#### Feature Table

<table>
<thead>
<tr>
<th>Feature</th>
<th>Standard Charts</th>
<th>Enhanced Charts</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allows animation</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Allows selection of font face and type</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Auto time cursor tracking</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Automatic padding for data plotting</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Baseline data source subsets</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Data quality legend</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Data sources can be added or deleted in run mode</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Exports chart data</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Line/multiline charts: while in run mode, can be viewed as another type of chart</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Line/multiline charts: can view subsets of data for comparison</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Log scale</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Multiple data plotting styles</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Multiple X and Y axes</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Feature</td>
<td>Standard Charts</td>
<td>Enhanced Charts</td>
</tr>
<tr>
<td>------------------------------------------------------</td>
<td>-----------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>Provides histograms</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Provides line/multiline charts</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Provides statistical process control charts</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Scrolling left to right</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Scrolling data source subsets</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Static Snapshot of chart</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Tag group substitution</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Time duration applies only to selected data source</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Time duration applies to entire chart (including mixed mode)</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Uses bitmaps and gradient fills</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Uses chart groups</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Uses the chart group wizard</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Variable orientation of X axis labels</td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>

**Plotting Different Types of Data**

iFIX charts plot three types of data:
• **Real-time** – Data that is current.

• **Historical** – Data obtained at a previous time by Historical Collect.

• **T_Data** – Data obtained from a trend block of a real-time data source.

The type of data plotted is determined by the data source you have selected. For Standard Charts, this is referred to as the pen type. For Enhanced Charts, it is referred to as Data Sources. The pen type, or data source, determines which properties are available in your chart. The following table lists some of the common pen, or data source properties and their availability for each type.

<table>
<thead>
<tr>
<th>Property</th>
<th>Historical</th>
<th>Real-time (including T_Data)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fixed Date</td>
<td>Enabled</td>
<td>Disabled</td>
</tr>
<tr>
<td>Fixed Time</td>
<td>Enabled</td>
<td>Disabled</td>
</tr>
<tr>
<td>Days Before Now</td>
<td>Enabled</td>
<td>Disabled</td>
</tr>
<tr>
<td>Duration Before Now</td>
<td>Enabled</td>
<td>Disabled</td>
</tr>
<tr>
<td>Interval</td>
<td>Enabled</td>
<td>Disabled</td>
</tr>
</tbody>
</table>

**NOTE:** If you are using a historical data source, the Tolerance, Deadband, and Refresh Rate fields have no effect on data retrieval.

This section primarily focuses on how to set properties for historical data you want to plot in a chart. For additional information on working with properties for real-time data, refer to the Adding a Chart section in the Creating Pictures manual.

### Displaying SQL Data

iFIX can retrieve data that is stored in a relational database and display the data in a chart. The term *SQL data* encompasses any data that you want to display in a chart that is stored in a relational database.

For example, you may perform quality tests on your products or processes and record data from these tests. iFIX lets you view this data as charts, arrays, or single values. You can view numeric data from a relational database provided that the database supports ODBC queries.

iFIX gives you full control over how you display and manipulate SQL data by letting you create and edit VBA scripts. Refer to the Writing Scripts manual for detailed information on VBA scripts. For more information on using SQL data sources, refer to the Using SQL manual.
Working with Enhanced Charts

The following sections describe how to modify many of the properties of an Enhanced Chart:

- Enhanced Chart Types
- Working with Enhanced Chart Properties
- Changing the Appearance of an Enhanced Chart
- Working in the Run-time Environment for Enhanced Charts
- Performance Considerations and Limitations for Enhanced Charts
- Exporting Data from an Enhanced Chart

Enhanced Chart Types

The following types of Enhanced Charts are available in the WorkSpace:

- X-Bar Charts
- R-Bar Charts
- S-Bar Charts
- Histograms
- Line/Multiline Charts
- XY Charts

The following sections describe each chart in detail:

- Statistical Process Control Charts (X-Bar, R-Bar, and S-Bar)
- Other Types of Enhanced Charts (Histogram, Line/Multiline, and XY)

Statistical Process Control Charts

Enhanced charts offer the ability to add statistical process control charts to your pictures. The charts use the Statistical Data database block type SD. These blocks collect data according to how you configure them, and display the collected data in run mode. The number of samples and other parameters are configured in the block, not through the WorkSpace. Refer to the Database Block Reference for more information on configuring Statistical blocks.

When you configure a data source for a statistical process control chart, you can only use statistical data tags. If you add a data source using the Expression Builder, only statistical data tags are available for selection. Similarly, if you choose to enter your data source directly in the Data Sources list of the expression editor and it is not a statistical data tag, you will receive an error message.

The statistical charts provide graphical data of key Statistical Data tag calculations. There are three statistical process control charts, which are X-Bar, R-Bar, and S-Bar.
Understanding X-Bar Charts

The X-Bar chart shows how the mean (or average) changes over time. This chart is used to analyze central location; that is, the center of a set of sample data. The statistic used to describe the central location is the mean.

Data for the X-Bar chart can be derived from subgroups of constant size or variable sizes.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The average over time</td>
</tr>
<tr>
<td>2</td>
<td>The Upper and Lower Warning Limits</td>
</tr>
<tr>
<td>3</td>
<td>The Upper and Lower Control Limits</td>
</tr>
</tbody>
</table>

Understanding R-Bar Charts

An R-Bar chart shows the range of the data. When creating statistical data, R is the range of the data; that is, the highest observed value minus the lowest. R-Bar is the average of the ranges for the subgroups collected.
Working with Enhanced Charts

**R-Bar Chart**

| 1 | The average of the ranges of the data for all subgroups |
| 2 | The Upper and Lower Control Limits |

**Understanding S-Bar Charts**

The S-Bar chart shows the standard deviation of the process, where $S$ represents the standard deviation of the process data, and the $S$-Bar represents the average of the standard deviations for the subgroups.
Trending Historical Data

<table>
<thead>
<tr>
<th></th>
<th>The average of the standard deviations for all subgroups</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>The Upper and Lower Control Limits</td>
</tr>
</tbody>
</table>

Other Types of Enhanced Charts

Other than the statistical process control charts, iFIX offers three other types of Enhanced charts. They are the histogram, line/multiline, and XY charts.

Each chart provides you with a particular way to visualize your data. Histograms show the distribution of a DataSet, while an XY chart illustrates the relationship between DataSets. Line/Multiline charts can help you visualize a trend in your data over time.

Data Sources and Chart Types

Each type of chart requires that you use a particular database block type, as detailed in the following table:

<table>
<thead>
<tr>
<th>Chart Type</th>
<th>Database Block to Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line/Multiline</td>
<td>Any</td>
</tr>
<tr>
<td>XY</td>
<td>Any block, except SD, HS, ETR, SQT, SQD, or PA</td>
</tr>
<tr>
<td>Histogram</td>
<td>HS</td>
</tr>
</tbody>
</table>

These blocks collect data according to how you configure them, and display the collected data in run mode. The number of samples and other parameters are configured in the block, not through the WorkSpace. Refer to the Database Block Reference for more information on configuring these blocks.

When you configure a data source for an Enhanced chart, you must use the appropriate tags. If you add a data source using the Expression Builder, only the appropriate tags are available for selection. Similarly, if you choose to enter your data source directly in the Data Sources list of the expression editor and it is not the correct type of tag, you will receive an error message.

Understanding Line/Multiline Charts

A Line/Multiline chart displays a trend in data over intervals of time. It can display historical and real-time data.
If you choose to use a real-time data source for your line/multiline chart, be aware that when you view it in run mode, the first data points will not be plotted until the time specified in the Chart Update Rate on the General tab of the Enhanced Chart Customization dialog box has elapsed. Therefore, there will be a lag time between when you open the chart in run mode and when the data is plotted; the first data point does not immediately display. This applies to tag group substitution, as well.

Examples of Charts with Multiple Y Axes

The following figure shows an example of a Line/Multiline Chart with multiple Y axes.
Trending Historical Data

The next figure illustrates an example of a Line/Multiline Chart with stacked Y axes.

Examples of Other Features Available in Line/Multiline Charts

Some of the other features that you can enable on a Line/Multiline charts are highlighted in the following figure.
The Quick Configure chart properties that can be modified in run mode are: Y Axes Style, Y Axes Always Visible, and Plot Visible.

The following table outlines each of the features highlighted in the previous chart.

<table>
<thead>
<tr>
<th>Screen Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>When the Quick Configure option is enabled, you can move the cursor to the upper left corner of the chart to display buttons to change the Y Axis Style to: Multiple, Stacked, or Single.</td>
</tr>
<tr>
<td>2</td>
<td>When you select the Show Time Cursor as Tooltips option, it displays tooltips such as these for the time cursor (the time cursor appears as the vertical black line in this figure).</td>
</tr>
<tr>
<td>3</td>
<td>Click on an item on this list (legend) to change the axes currently being viewed in the chart.</td>
</tr>
</tbody>
</table>
Understanding XY Charts

An XY chart allows you to visualize how two or more types of data, such as temperature and pressure, are affected by one another. Using the chart, you can determine the type of relationship between two DataSets.

In XY charts, you can use either real-time data or historical data, but not both on the same chart. The data is refreshed and plotted based on the settings for the X axis.

<table>
<thead>
<tr>
<th>Screen Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>When the Quick Configure option is enabled, you can click the Yes or No option in this column to toggle the Plot Visibility setting for each data source.</td>
</tr>
<tr>
<td>5</td>
<td>When the Quick Configure option is enabled, you can click the Yes or No option in this column to toggle the Y axis Always Visible property for each data source.</td>
</tr>
<tr>
<td>6</td>
<td>When the Quick Configure option is enabled, these two columns appear in the Legend.</td>
</tr>
</tbody>
</table>
Working with Enhanced Charts

**XY Chart**

The axis used as the data source is underlined in the data source legend. In the preceding illustration, the Y axis is underlined, which indicates that the second data source added during configuration of the XY chart was selected for the horizontal axis.

If you choose to use a real-time data source for your XY chart, be aware that when you view it in run mode, the first data points will not be plotted until the time specified in the Chart Update Rate on the General tab of the Enhanced Chart Customization dialog box has elapsed. Therefore, there will be a lag time between when you open the chart in run mode and when the data is plotted; the first data point does not immediately display. This applies to tag group substitution, as well.

**Understanding Histograms**

A Histogram chart (also referred to as a Normal chart), is a bar graph that shows the distribution of a DataSet.

The Histogram graphically shows the following:

- Center of the data – which is measured by mean, median, and mode.
- Spread of the data – how different the values are from the each other and from the middle.
- Presence of outliers – outliers are points on a chart that do not fall into the pattern.
- Presence of multiple modes in the data – the shape of the histogram may reveal multiple 'peaks'.

![Histogram Chart](image)

**Working with Enhanced Chart Properties**

The following sections describe how assign specific properties to Enhanced Charts:

- Applying Enhanced Chart Properties
Trending Historical Data

- Naming an Enhanced Chart
- Entering an Enhanced Chart Description
- Defining Data Sources for Enhanced Charts

Applying Enhanced Chart Properties

There are several ways you can apply selected properties to your charts using the Chart Customization dialog box:

- Select a new data set in the Data Sources list.
- Click OK.
- Click Apply.
- Select the Apply to All Data Sources check box.

Each of these methods are described in the following table.

<table>
<thead>
<tr>
<th>Methods of Applying Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use this method...</td>
</tr>
<tr>
<td>Select a new data source in the Data Source list</td>
</tr>
<tr>
<td>Click OK</td>
</tr>
<tr>
<td>Click Apply</td>
</tr>
</tbody>
</table>
### Methods of Applying Properties

<table>
<thead>
<tr>
<th>Use this method...</th>
<th>To...</th>
</tr>
</thead>
</table>
| Select the Apply to All Data Sources check box | Apply properties to all data sources added to a chart. Refer to the Applying Properties to All Data Sources section below for more information.  

*NOTE: The Apply to All Data Sources check box applies only during the current configuration session. The default (that is, the check box is cleared) is restored the next time you open the Chart Configuration dialog box.* |

### Applying Properties to all Data Sources

iFIX allows you to easily define time, X and Y axis, grid, and legend properties for every data source you add to your chart. You can do this by simply selecting the Apply to All Data Sources check box on the Time tab on the Data Sources tab. For example, you may want all of the data sources in your chart to have the same legend. To accomplish this, click the Legend tab and select the properties you want. Next, select the Apply to All Data Sources check box. Exit the dialog box by clicking OK.

### Naming an Enhanced Chart

The Name field allows you to enter a specific name for your chart. To change the name, enter an alternate name in the Name field.

### Entering an Enhanced Chart Description

The Description field allows you add a description for your chart. The description is a VBA property and can be any name that will help you identify the purpose of the chart.

### Defining Data Sources for Enhanced Charts

One of the most dynamic features of charts is the integration of both real-time and historical data in the same chart, which lets you easily view all types of data in the Proficy iFIX WorkSpace. You need to define the data sources you want to trend. The following sections show you how to select a data source and configure its properties.

### Adding Data Sources to Your Chart

Each data source must be defined. At the top of the Data Sources tab of the Chart Customization dialog box is the Data Sources List area, which lists the data sources in *Data Server.NODE.TAG.FIELD* format.

*NOTE: If you are adding a data source to an SPC (X-Bar, R-Bar, or S-Bar) Chart, you must use the SD block. For a histogram, you must use the HS block. For XY charts, you can use any block except SD, HS, ETR, SQT, SQD or PA.*
There are many ways to add a new data source to your chart:

- Click Add in the Data Sources List area, and enter a data source in the field that appears.
- Double-click a blank field in the Data Sources List and enter a data source in the field.
- Click the Browse button to the right of the field to display the Expression Builder, which allows you to search for global data sources through a data source browser. To learn how to use the Expression Builder and define data sources, refer to the Animating Object Properties chapter in the Creating Pictures manual. For more information on data sources, refer to the System Architecture section of the Understanding iFIX manual.
- Write a VBA script. Refer to the Writing Scripts manual for more information.

For XY charts, you can only add two data sources, one for the X axis and one for the Y axis.

To modify an existing data source in the Data Sources list, double-click the data source and enter an alternate data source. To change the order of the data source in the chart's legend, click the data source you want to move in the Data Sources List area, and then click either the up or down arrow.

To delete a data source, select the data source from the list and click the Delete button.

**Defining Data Properties**

To control how the data is presented by the configured data source(s), you can define the data properties for your chart. You can do this by selecting the properties you want on the Data tab on the Data Sources tab. The following properties can be defined:

- **High Limit** – Displays the high limit value defined for the selected data source.
- **Low Limit** – Displays the low limit value defined for the selected data source.
- **Fetch Limits** – At run-time, automatically retrieves the low and high limits assigned to the selected data source. If this option is selected, then the manually entered High and Low Limits will not be considered.
- **Show Gaps** – Determines whether a blank space or a line is displayed to represent an area in a plot where there is no data. This field is not available for XY charts.
- **Interpolate Data** – Causes the lines between plotted data to display as slopes, rather than flat lines. This field is not available for XY charts.
- **Maximum Display Points** – Determines how many data points will be displayed for the data source over a given span duration. This field is not available for XY charts.
- **Historical Mode** – Determines how iFIX selects data from a historical data source and displays it in the chart, and determines what each displayed value represents. This field is not available for XY charts.

The following table provides some examples of data properties applied to a chart.
Data Property Examples

<table>
<thead>
<tr>
<th>Use this property...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>High Limit Low Limit</td>
<td>Specify high and low limit values for trending. To do this, enter the low and high limit values you want to trend for the selected data source in the Low Limit and High Limit fields, respectively.</td>
</tr>
<tr>
<td>Fetch Limits</td>
<td>Retrieve the limit range assigned to the data source at run time. For example, you may have a data source with limits that are unknown or prone to change in the configuration environment. By selecting Fetch Limits, you can set the data source's high and low limits equal to that of the data source at run time.</td>
</tr>
<tr>
<td>Maximum Display Points</td>
<td>Determine how many data points display for the data source in the chart based on a set duration. For example, if the maximum points are 500, and the duration is 500 seconds, then the maximum number of points that the chart will maintain is 1 per second.</td>
</tr>
</tbody>
</table>

Selecting a Historical Display Mode

*NOTE: This feature is not available for XY charts. The data is always interpolated.*

Data sources displaying historical data offer additional flexibility in how the data is displayed by offering a *historical mode*, available on the Data tab on the Data Sources tab. Select a mode from the Historical Mode drop-down list. The display mode determines how iFIX selects data from a historical data source and displays it in the chart, and determines what each displayed value represents.

Historical modes are directly related to Span Interval and Span Duration properties for the time group. The Span Interval determines the range of data that the display mode uses to calculate the point of data that is trended. Time group properties are further described in the Defining Time Ranges section.

The following table shows the different historical modes you can choose from, and how trending differs for each mode.

<table>
<thead>
<tr>
<th>Historical Modes</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you select this mode...</td>
</tr>
<tr>
<td>Sample</td>
</tr>
</tbody>
</table>
### Historical Modes

<table>
<thead>
<tr>
<th>If you select this mode...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Avg</td>
<td>The average of all valid data found during the interval is trended, starting at the beginning of the interval, 12:00:00.</td>
</tr>
<tr>
<td>High</td>
<td>The highest valid data point value found during the interval is trended, starting at the beginning of the interval, 12:00:00.</td>
</tr>
<tr>
<td>Low</td>
<td>The lowest valid data point value found during the interval is trended, starting at the beginning of the interval, 12:00:00.</td>
</tr>
<tr>
<td>Interpolated</td>
<td>The data is interpreted by assuming that the line between two values is a straight line. All points along that line are estimated except the starting point and the ending point. Simple linear interpolation is used to estimate the line. Available for Proficy Historian only.</td>
</tr>
<tr>
<td>Trend</td>
<td>The raw data for the minimum and maximum values for each interval is returned.</td>
</tr>
</tbody>
</table>

Let's examine an example of a data source configured to display in sample mode. Assume that the following data is available for a data source and the Interval is set to 10 minutes.

<table>
<thead>
<tr>
<th>Time</th>
<th>Data Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>12:00:00</td>
<td>0.0</td>
</tr>
<tr>
<td>12:01:00</td>
<td>1.00</td>
</tr>
<tr>
<td>12:02:00</td>
<td>2.00</td>
</tr>
<tr>
<td>12:03:00</td>
<td>3.00</td>
</tr>
<tr>
<td>12:04:00</td>
<td>4.00</td>
</tr>
<tr>
<td>12:05:00</td>
<td>5.00</td>
</tr>
<tr>
<td>12:06:00</td>
<td>6.00</td>
</tr>
<tr>
<td>12:07:00</td>
<td>7.00</td>
</tr>
<tr>
<td>Time</td>
<td>Data Value</td>
</tr>
<tr>
<td>----------</td>
<td>------------</td>
</tr>
<tr>
<td>12:08:00</td>
<td>8.00</td>
</tr>
<tr>
<td>12:09:00</td>
<td>9.00</td>
</tr>
</tbody>
</table>

Using the above chart, the values are trended as indicated:

- **Avg** – 4.5 is trended from 12:00:00 to 12:10:00.
- **High** – 9.0 is trended from 12:00:00 to 12:10:00.
- **Low** – 0.0 is trended from 12:00:00 to 12:10:00.

The value, 0.0 at 12:00:00 (the start of the interval), is trended for the duration of the interval, from 12:00:00 up to 12:10:00. If 0.0 is not a valid point, then the last valid value found prior to the start of the interval is trended.

You can enter a data source more than once to display data in different modes. For example, if you trend an Analog Input block, you can enter the block twice in the Data Sources List: once in Sample mode, and again in Average mode.

**NOTE**: Sample mode is the fastest mode for displaying historical data. However, the average, high, and low modes may provide more detailed data values for your application. The trend mode is the preferred mode for retrieving data for plotting over long time periods.

### Understanding Enhanced Chart Data Source Limits Symbols

In Enhanced Charts, if the values for the data source limits are particularly large or small, symbols are used to represent the value and are substituted for zeros. This minimizes the area required for labels and increases the chart display area. For example, in the following figure, the values for the axes are followed by a "B", indicating that the values are in the billions. The "B" replaces the nine zeros.
Data Source Value Symbols

The following table describes the meaning of the symbols used in the Enhanced Charts.

<table>
<thead>
<tr>
<th>Value</th>
<th>Unit of Measure</th>
<th>Symbol Used</th>
</tr>
</thead>
<tbody>
<tr>
<td>$1 \times 10^{-12}$</td>
<td>pico</td>
<td>p</td>
</tr>
<tr>
<td>$1 \times 10^{-9}$</td>
<td>nano</td>
<td>n</td>
</tr>
<tr>
<td>$1 \times 10^{-6}$</td>
<td>micro</td>
<td>u</td>
</tr>
<tr>
<td>$1 \times 10^{3}$</td>
<td>milli</td>
<td>m</td>
</tr>
<tr>
<td>$1 \times 10^{6}$</td>
<td>kilo</td>
<td>K</td>
</tr>
<tr>
<td>$1 \times 10^{9}$</td>
<td>mega</td>
<td>M</td>
</tr>
<tr>
<td>$1 \times 10^{12}$</td>
<td>billion</td>
<td>B</td>
</tr>
</tbody>
</table>
## Chart Data Source Limit Symbols

<table>
<thead>
<tr>
<th>Value</th>
<th>Unit of Measure</th>
<th>Symbol Used</th>
</tr>
</thead>
<tbody>
<tr>
<td>1x10^{12}</td>
<td>tera</td>
<td>T</td>
</tr>
</tbody>
</table>

## Scrolling an Enhanced Chart

### Plotting Ideal Curves

A chart's left-to-right scrolling functionality helps you easily determine how close your data is to a desired value. It does so by letting you easily recognize ideal and actual curves in the same chart. An ideal curve is an existing historical plot that represents an ideal condition in your process. The actual curve is a real-time plot that represents current conditions. Depending on your process, it may be crucial that the actual curve come as close as possible, if not exactly match, the ideal curve.

For example, let's say you want to plot real-time data so that it shows the proper variation in temperature of a process, determined by a plot collected previously. Using multiple data sources and scrolling in iFIX charts, you can view the real-time and historical data simultaneously to determine whether data that is currently being fetched matches the ideal scenario.

iFIX charts give you the ability to monitor crucial fluctuations in data which, in many cases, can greatly impact your process.

### Scrolling an Enhanced Chart

To scroll an enhanced chart, use the Historical Line Chart Dynamo, available in the Dynamo Sets folder in the Proficy iFIX WorkSpace system tree. Add the Dynamo to your picture and double-click it. The Historical Line Chart Customization dialog box appears, which lets you make changes to the chart's properties.

The following figure illustrates the controls available for date and time selection, as well as scrolling, in the Historical Line Chart Dynamo.
Trending Historical Data

Chart Configuration Considerations

There are some considerations to keep in mind when configuring the Historical Line Chart Dynamo.

- If you want to use a key macro, or a click event for the Historical Line Chart Dynamo, clear
the Selectable checkbox on the General tab on the Historical Line Chart Customization dialog box. Otherwise, when you click on the Dynamo in run mode, the key macro or click event does not work properly, because only the chart is selected, not the entire Dynamo. If you choose to leave Selectable enabled, then make sure to add your key macros and click script events to both the line chart and Dynamo objects.

• The Days Before Now and Duration Before Now fields, which are located in the Start Time area of the Time tab, of the Data Sources tab, on the Historical Line Chart Customization dialog box, are disabled. Any entry you make in these fields is disregarded. However, you can use the Fixed Date and Fixed Time fields of the first data source listed in the Data Sources list to set the start date and time. The Fixed Date and Fixed Time used for the first data source in the Data Sources list applies to all data sources, causing all data sources to start on the same date and time on the chart.

**IMPORTANT:** Do not disable FixedDate and FixedTime in the Property Window or in VBA. *If you disable them, the chart will not work correctly.*

• The initial date and time that appear on the chart in run mode are based on the start date and time configured in the Start Time area on the Time tab of the Data Sources tab for the first data source listed in the Data Sources list. While in configuration mode, if you use a method other than completing the Line Chart Customization dialog box to set the start date and time in the Date and Time Picker fields, when you switch to run mode, the start date and time on the chart axis will not match the date and time you configured. Instead, they will match the start date and time entered on the Time tab for the first data source in the Data Sources List.

• If you use only real-time data sources, the chart does not scroll.

### Using the Historical Line Chart Dynamo

Click the arrows on the bottom of the chart to scroll the chart in a particular direction. Depending on the arrow selected you will move forward or backward either 25 or 50% of the chart's duration. The chart's duration is set on the General tab in the Duration area of the Historical Line Chart Customization dialog box.

You can use the date and time picker to specify exactly where you want your chart to begin. To choose a date, click the Date Picker selection box arrow; on the calendar that appears, click on the desired date. To choose a time, you can either enter the desired time directly in the Time Picker selection box, or use the Time Picker selection box arrows to change the time.

**NOTES:**

• Changing the time using the Time Picker does not change the date displayed on the Date Picker. So, for example, if you move the time from 11 p.m. to 12 a.m., the date remains the same in the Date Picker; it does not advance one day.

• When running the Historical Line Chart Dynamo with a Historical Update Rate set, the dates and times displayed in the Date and Time Pickers are not automatically updated to reflect the new start time of the chart upon refresh.

**IMPORTANT:**

• The Quick Dynamo Updater and Dynamo Updater Wizard are not available for the Historical Line Chart Dynamo because it is not a true Dynamo object.

• *If you use multiple historical data sources, the time period for the chart is the same for all sources. It is based on the date and time selected using the Date and Time Pickers.*
You can change the chart's scroll percentage using VBA scripts. For more information on using scripts to scroll charts, refer to the Writing Scripts manual.

---

**Changing the Appearance of an Enhanced Chart**

The following sections describe how to customize the appearance of an Enhanced Chart:

- Adding a Title to an Enhanced Chart
- Changing the Refresh Rate for an Enhanced Chart
- Understanding Refresh Rates for Enhanced Charts
- Configuring the Legends for an Enhanced Chart
- Choosing a Border Style for an Enhanced Chart
- Choosing the Format and Precision of Data to Display for Enhanced Charts
- Defining a Grid for an Enhanced Chart
- Defining Time Ranges for an Enhanced Chart
- Configuring the X and Y Axis for an Enhanced Chart
- Choosing Fonts for Enhanced Charts
- Changing the Color Scheme of an Enhanced Chart
- Defining the Plotting Style for Enhanced Charts

---

**Adding a Title to an Enhanced Chart**

Adding a title to your chart will help you to see at a glance what type of information the chart contains.

The Main Title field allows you to enter a specific title for your chart. When you first add a chart to your picture the default title that appears is *Chart Type*. For example, if you add an X-Bar chart to your picture, the title will read *SPC X Bar*. To change the name, enter the desired name in the Main Title field.

Additionally, you can add a subtitle to your chart, for further clarification of the chart information. To add a subtitle, enter it in the Subtitle field on the General tab of the Chart Customization dialog box.

---

**Changing the Chart Update Rate for an Enhanced Chart**

The chart update rate determines how quickly a chart updates the data plot in the run-time environment. The faster the chart refresh rate, the slower the performance will be, as the chart needs to be redrawn each time it is refreshed at the specified refresh rate.

You can specify a chart refresh rate for your chart by entering a rate, in seconds, in the Chart Update Rate field, in the Appearance area on the General tab of the Chart Customization dialog box. For real-time data sources, the refresh rate can be from 0.1 seconds to a maximum of 1800 seconds, or 30 minutes, and can be entered in 0.1 second intervals. For historical data sources, the refresh rate can be from 5 seconds to a maximum of 1800 seconds, or 30 minutes.
Understanding Refresh Rates for Enhanced Charts

There are a number of refresh rates that are involved with presenting data on a chart. In order to get the best appearance from your charts, it is necessary to understand how the rates interact.

<table>
<thead>
<tr>
<th>Type of Refresh Rate</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block Scan Time</td>
<td>The scan time, or the frequency of the interaction between the PLC and the SCADA.</td>
</tr>
</tbody>
</table>
| Real-time Data Refresh Rate | The frequency at which the database updates the information from the block. This rate should not be set to a higher value than the block scan time value. This value is set on the Expression Builder dialog box.  
For XY charts, this update rate applies to both real-time and historical data sources. |
| Chart Update Rate       | The frequency at which the chart retrieves data from the database. This rate should not be set to a higher value than the real-time data refresh rate. Doing so may result in flat line areas in your chart, because the chart is retrieving data faster than the database is receiving updates. This value is set in the Appearance area of the General tab of the Chart Customization dialog box. |
| Historical Update Rate  | The frequency at which the chart retrieves historical data from the Historian. This value is completely independent of the other three refresh rates, which are interdependent. Because the historical update rate is independent of the other refresh rates, when historical data is plotted on a chart with real-time data, it will not update in the same way. Its plotting behavior is best exemplified on Standard Charts.  
NOTE: This option does not apply to XY charts. |

Configuring the Legends for an Enhanced Chart

The legend lets you quickly identify the information that the chart is plotting. In Enhanced Charts, charts may display up to two legends, which include the plotting style and data source legends. To determine which legends appear on your chart, select or clear the legend check boxes in the Miscellaneous area on the Chart Style tab.

Plotting Style Legend

The plotting style legend, if enabled, appears at the top of the chart. For line/multiline charts, the plotting style legend displays the color and point or line type for each data source. For SPC charts, including X-bar, R-bar, and S-bar charts, the plotting style legend displays the color for the data source, the upper and lower control limits, the upper and lower warning limits, and the bar value. For XY charts, the plotting style legend displays the color and point, or line type for the Y axis data source.
**Data Source Legend**

The data source legend, if enabled, appears at the bottom of the chart. For line/multiline and XY charts, the data source legend provides collection and error information for each data source. For SPC charts, including X-bar, R-bar, and S-bar charts, in addition to the collection information, the upper and lower control limits, the upper and lower warning limits, and the bar value also appear. To configure the data source legend, click the Data Sources tab on the Legend tabbed page of the Chart Customization dialog box.

You can modify the data source legend. You can add or remove items from the legend, as well as change the order of the items that appear. However, for XY charts, you cannot remove the axis indicators; they are always present. To add or remove items from the chart's legend, click the Legend tab and select or clear the property check boxes of the legend. The Order list of the Legend Column Widths area on the Chart Style tab lets you display the items you select in any order in the legend (left to right). To change the number of characters permitted for each legend description, change the value in the corresponding field on the Chart Style tab in the Legend Column Widths area.

**Choosing a Border Style for an Enhanced Chart**

You can choose the type of border you want for your chart. Your selection is applied to both the graph and table.

To choose a border style, make a selection in the Border Style area on the Chart Style tab on the Chart Customization dialog box.

*NOTE:* Settings chosen on the Chart Style tab override the settings chosen on the Color tab.

**Choosing the Format and Precision of Data to Display for Enhanced Charts**

With all Enhanced Charts, except for the XY chart, you can choose to display your data in a graph, a table, or both. How you plan to use the data and who is looking at it will determine your choice of format for data display. You can choose the format for your data in the Display area, on the Chart Style tab on the Chart Customization dialog box.

You can also select a level of numeric precision, or the number of decimal points used for your chart. However, decimal points do not appear on the chart, even if you specify a high level of precision unless they are necessary. You can set the level of numeric precision in the Numeric Precision area, on the Chart Style tab on the Chart Customization dialog box.

**Defining a Grid for an Enhanced Chart**

The grid in your chart gives you a point of reference when data points move across the chart. iFIX gives you precise control of both the horizontal and vertical axis of your grid. You can select whether to display the grid, which axis to display, whether the grid is in front of the data, and the grid style.

To define a grid, click the Chart Style tab and select the desired options in the Grid Lines area.

**Defining Time Ranges for an Enhanced Chart**

For historical data sources only, you can assign a time range to data sources in the chart, using the Time tab on the Data Sources tab on the Chart Customization dialog box. This allows you to examine data from a specific period of time.
To define time ranges, click the Time tab on the Data Sources tab and enter the time ranges in the appropriate fields.

**NOTE:** Time range selection is available only for Line/Multiline and XY charts.

### Configuring the X and Y Axis for an Enhanced Chart

You can configure an axis by clicking the Axis tab. There, you can specify the label for both axes.

For the Y axis, you can set the values including the minimum, maximum, or both, or have iFIX automatically generate the Y axis range, by selecting the Use Data Source Limits field. If you choose to allow iFIX to auto generate the Y axis range, you can enter a value in the padding field. This causes the chart to show values that exceed the maximum and minimum values, thus allowing some padding on either side of the range. The padding is measured as a percentage of the total Y axis. For line charts only, you can choose to use either linear or log values as the unit of measure. Optionally, you can choose to extend the Y axis tick marks on the Chart Style tab.

For the X axis, on the Chart Style tab, you can select the label orientation. The X axis labels do not reflect the actual time stamp of the data. The X axis time stamps are calculated based on the duration and/or start time defined for the data source selected for the horizontal axis. The horizontal axis's data source defaults to the one at the top of the list in the Data Sources List field on the Data Sources tab of the Chart Customization dialog box. In run mode, you can change the data source selected for the horizontal axis by clicking on another data source in the Chart Legend. The actual data time stamps appear in the Time Cursor Legend.

For XY charts, you can configure the X axis to use either linear or log values as the unit of measure. You can also choose to have iFIX automatically generate the X axis range, by clearing the Use Data Source Limits check box. If you choose to allow iFIX to auto generate the X axis range, you can enter a value in the padding field.

### Choosing Fonts for Enhanced Charts

You can choose the font type and face to use for your charts. The font size selections you make are applied to all chart items including the title, sub-title, subset, points, axis labels, and table data.

You can also choose the display size of the fonts. However, when choosing a size, keep in mind that the total area available for your chart does not change, even if the font size does. Therefore, the size you choose for the font impacts the available area for chart display. For example, in the following table, the large size font provides much less space on the chart for actual data display, than does the small size font.
<table>
<thead>
<tr>
<th>For the following chart...</th>
<th>the font size selected is...</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Chart Image" /></td>
<td>small</td>
</tr>
<tr>
<td><img src="image2" alt="Chart Image" /></td>
<td>medium</td>
</tr>
</tbody>
</table>
For the following chart...

<table>
<thead>
<tr>
<th>the font size selected is...</th>
</tr>
</thead>
<tbody>
<tr>
<td>large</td>
</tr>
</tbody>
</table>

To make your font choices, double-click your chart, and on the Chart Customization dialog box, click Font, and choose your font size, face, and style.

**Font Selection Considerations**

The following suggestions will make your chart easier to read:

- Use the same font face for all chart elements.
- Apply only one font style to each chart element. For example, use only bold or italic for the title, rather than both.
- Limit use of the italic style.

**Changing the Color Scheme of an Enhanced Chart**

You can view your chart in color, monochrome, or in monochrome + symbols. If performance is an issue, you will probably want to view your chart in monochrome because it is less taxing on the system.

If you choose to view your chart in color, you can customize every color aspect of the chart's appearance. The following illustration highlights each of the items you can customize, which include titles, legends, and graphs.
iFLX Enhanced Chart with Color Customization

1. Desk Foreground
2. Desk Background
3. Shadow Color
4. Graph Foreground
5. Graph Background
6. Table Foreground
Using Pre-Set Styles

For easy color-customization of your chart, you can use a pre-set style. Pre-set styles provide comprehensive color themes for your chart. There are twelve themes available in light, medium, or dark color combinations. Additionally, you can easily add gradient shades to your chart. In the following example, Dark Inset was selected as the pre-set style. By applying a bitmap or gradient style to the Dark Inset, the chart on the right results.

![Dark Inset Selected](image1)

![Bitmap / Gradient Styles and Dark Inset Selected](image2)

*iFIX Enhanced Charts with Pre-Set Color Styles Applied*

To customize your chart's colors, double-click your chart, and on the Chart Customization dialog box, click Color, and choose your viewing style, graph attributes and style.

**Color Selection Considerations**

We recommend keeping the following suggestions in mind when making your chart color selections:

- If performance is an issue, avoid using color. Instead, view your charts in monochrome.
- Avoid the use of too many bright colors. It can make your chart unpleasant to look at. Instead, use bright colors to highlight specific information, thus drawing attention where you want it.
Defining the Plotting Style for Enhanced Charts

Defining the plotting style for an enhanced chart includes choosing the type of line you want to use to plot your data, selecting the data point type, choosing the color for the line, labels and data points, and adding shadows to the data points, if desired. For line/multiline charts, you may also select the type of chart to use.

All plotting style choices can be selected on the Plotting Style tab of the Chart Customization dialog box.

Working in the Run-time Environment for Enhanced Charts

The following sections describe how to configure Enhanced Charts for specific attributes in the run-time environment:

- Defining Run-time Attributes for an Enhanced Chart
- Zooming in an Enhanced Chart
- Displaying Time Cursors in an Enhanced Chart
- Understanding Chart Time for Enhanced Charts
- Adjusting for Daylight Savings Time for Enhanced Charts
- Choosing Subsets for Line/Multiline Graphs
- Marking Data Points in an Enhanced Chart

Defining Run-time Attributes for an Enhanced Chart

You can assign certain attributes in the configuration environment to make the chart accessible when you switch to the run-time environment. You can specify these attributes by selecting the appropriate check boxes on the General tab page of the Chart Customization dialog box. The following table describes each attribute.

<table>
<thead>
<tr>
<th>Selecting the check box...</th>
<th>Lets you...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Highlightable</td>
<td>Highlight the object at run-time.</td>
</tr>
</tbody>
</table>
| Selectable                | Select the object at run-time.  
**Example:** Zoom in on an area of the chart. |
| Modifiable                | Modify the object at run-time.  
**Example:** Modify chart properties using the Chart Configuration dialog box. |
<table>
<thead>
<tr>
<th>Selecting the check box...</th>
<th>Lets you...</th>
</tr>
</thead>
</table>
| Expandable                | Expand or Contract the chart at run-time. **Example:** Move the cursor to the upper right corner of the chart at run time. An Expand or Contract button appears. The Expand button displays the chart in full screen; the Contract button resets the chart to its original size and position. The hot keys 'E' and 'C' (upper and lower case) can also be used to Expand or Contract the chart if it has focus.  

**NOTE:** If a chart has the Thumbnail property set to true then when the chart is expanded the Thumbnail property will be set to false. When the chart is contracted the Thumbnail property will be set back to true. |

**Zooming in an Enhanced Chart**

When a chart is selectable, you can zoom to an area of the chart by placing the cursor within the chart area and clicking an area, or enclosing an area in a rectangle selector. When the cursor is in the chart area, it becomes a magnifying glass. You can zoom to the horizontal, vertical, or both axes in the chart to view specific data. To zoom out on the chart, press Z. Alternatively, you can use the right-click menu. Select Chart Options and then Undo Zoom.

To enable zooming for your chart, on the General tab of the Chart Customization dialog box, select the desired zooming capability.

**Displaying Time Cursors in an Enhanced Chart**

You can choose to display time cursors in the run-time environment. The time cursor appears as a crosshair, which moves as you move the mouse. The value of the time cursor is displayed in the legend. For historical pens, the value at the point of the time cursor is displayed; for real-time pens, the current value is always displayed.

To display the time cursor in the run-time environment, select Show Time Cursor on the General tab of the Chart Customization dialog box. If you have chosen to display the time cursor as tool tips, clicking in the plot area freezes the time cursor where clicked; clicking again frees the cursor.
**Trending Historical Data**

**Enhanced Chart with Time Cursor**

<table>
<thead>
<tr>
<th>1</th>
<th>Time Cursor</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Time Cursor Values</td>
</tr>
</tbody>
</table>

**NOTE:** The chart must be selectable to view the time cursor at run time.

**Displaying Hover Tool Tips in an Enhanced Chart**

You can display tool tips in the run-time environment. When tool tips are enabled, placing the mouse pointer over a point in the chart causes the value of the point, along with the time and date stamp for that point, to display in a pop up box.

In the following figure, which depicts a line chart, the point, along with the time stamp appear in the pop up box.
Enhanced Line Chart with Tool Tips Enabled

In the following figure of an XY chart, the X and Y values for the point are displayed, as shown in the green pop up box.
To display the tool tips in run mode, select Show Hover Tool Tip on the General tab of the Chart Customization dialog box.

**Displaying Data Point Labels in an XY Chart**

You can display the labels for all data points in an XY chart in the run-time environment.

The following figure displays an XY chart where the values, or labels, for all of the data points are displayed. It also illustrates a second way to view the values for a single data point, the tool tip. The tool tip, along with the time stamp, appear in the green pop up box. Enabling data point labels allows you to read all of the points' values at once. And, the values continue to display for as long as the chart is displayed in run mode. To check the value of a single point, you can use the tool tip. The value of the selected data point does not continue to display after you move the tool tip away from it.
To display the data points labels in run mode, select Include Data Labels in the Miscellaneous area on the Chart Style tab of the Chart Customization dialog box.

**Data Source Limit Symbols**

If your chart uses data source limit symbols to demarcate the axes limits, the Data Point Labels will use those too. In the following figure, the Tool Tips display the actual value; the Data Point Labels do not. Instead, the labels reflect the same substitution as the data source limits; the zeros and the data source limit symbol are implied. For more information on data source limit symbols, refer to Understanding Enhanced Chart Data Source Values Symbols.
Understanding Chart Time for Enhanced Charts

The relationship between the following fields must be considered when you use a fixed start time and date in a chart:

- Lock Time
- Time Zone (Proficy Historian only)
- Adjust for Daylight Savings Time (Proficy Historian only)

iFIX charts save time as Coordinated Universal Time (or UTC time). When you switch to the run-time environment, UTC time is read from the picture file containing the chart, and is then converted to local time before the chart fetches data from the historical file. Therefore, when you configure a chart, time is entered and displayed in local time. However, the time saved within the chart is in UTC time, which allows the data to be displayed independently of specific time zones.

The following examples help explain the concept of using time zones and daylight saving.

**Example 1: No Features Enabled**

In this example, pictures are created and saved in Eastern Standard Time (EST). The Duration Before Now is set to 01:00:00, Days Before now is set to 0, and the current time is 10:00 a.m.. You get these results when you open the picture in the indicated time zone:

**EST** – displays data from 9:00 to 10:00 a.m.

**CST** – displays data from 8:00 a.m. to 9:00 a.m. local time.
Example 2: Lock Time Feature is Enabled

In this example, pictures are created and saved in EST. The Lock Time is selected, the Duration Before Now is set to 01:00:00, Days Before now is set to 0, and the current time is 10:00 a.m. You get these results when you open the picture in the indicated time zone:

EST – displays data from 9:00 to 10:00 a.m. local time.

Example 3: Using Server Time Zone (Proficy Historian only)

A picture configured to use the server time zone can be opened on any client machine in any time zone and will always show the same plot of data.

Example 4: Displaying Data from Multiple Time Zones (Proficy Historian only)

You have some points in the Proficy Historian archive that contain data from Mountain Standard Time (MST) and some from Pacific Standard Time (PST). You want to create a chart to display the events that occurred in each time zone at 10:00 a.m. Rather than being required to know the exact time zone location of each point and then choosing explicit time zones, you can select the tag time in the Time Zone field and set the Fixed Time at 10:00 a.m.

The UTC time feature of iFIX charts allows you to easily view and analyze a data plot, no matter where you display the data.

Adjusting for Daylight Savings Time for Enhanced Charts

If you are a Proficy Historian user, you have the option to adjust for daylight saving time. If you choose to adjust for daylight saving time, verify that Adjust for Daylight Savings Time is selected on the Time tab on the Data Sources tab when you add a DataSet to an iFIX Enhanced chart.

Before allowing automatic Daylight Saving Time to be used in a production environment, you should test your application under each of the following scenarios for proper behavior:

- While in Standard Time.
- While in Daylight Time.
- During the transition from Standard Time to Daylight Time.
- During the transition from Daylight Time to Standard Time.

Choosing Subsets for Line/Multiline Graphs

On an Enhanced Line/Multiline Chart, you can analyze a subset of the data presented in the graph. This is accomplished by selecting the number of data sources you want to analyze per graph from the Scrolling Subsets area on the Subsets tab of the Chart Customization dialog box. You may also select a data source, which will be present on all subset graphs by selecting it from the Baseline Subsets to Graph area.

After you have configured your subsets, you can view the results in run mode, where you can scroll through each of the subset graphs.
Trending Historical Data

Marking Data Points in an Enhanced Chart

If you want a very precise depiction of the data, you can mark each of the data points. This way, in addition to viewing the data in a smoothed line, you can see each of the individual data points.

You can view the data points on an enhanced chart by selecting Mark Data Points in the Miscellaneous area on the Chart Style tab of the Chart Customization dialog box.

Performance Considerations and Limitations for Enhanced Charts

We recommend the following measures to keep your system's performance acceptable:

- Limit your charts to no more than 10 data sources per chart.
- Limit your charts to no more than 5 charts per picture.
- Avoid using the Snapshot feature if you are using an older CPU or lower end graphics card. In such a situation, the power necessary to create a full-screen Snapshot will cause other system processes to have very limited access to resources and may limit their performance.
- As a last resort, use the Monochrome Viewing Style.
- Do not use Classic Historian. Classic Historian is not supported for Enhanced Charts.
- The Bring to Front and Send to Back right-mouse functionality for the Enhanced Chart objects only applies when working with other Enhanced Chart objects. You cannot use the Bring to Front and Send to Back right-mouse functionality for Enhanced Charts and other objects and Dynamos. For example, you can bring a Line Chart in front of/behind another Line Chart or XY Chart, for instance. But, you can't bring that same chart in front of/behind a rectangle or Dynamo, for example.

Exporting Data from an Enhanced Chart

Enhanced Charts allow you to export the data from a chart to a variety of formats. You can export the data to either picture or text/data format. If you choose to export the chart data to a picture format, such as EMF or JPG, you can choose the export size of the document, as well as the export location – the clipboard, a printer, or a file. If you choose to export the chart data to a text/data format, you can choose to export to the clipboard or a file.

When the data is exported, it can be used in a variety of ways and for multiple purposes, including further statistical analysis in Excel or for PowerPoint presentations.

If you export the chart data in a text/data format, the first row or column of the exported data represents the X axis and the second row or column represents the Y axis. Whether the axes are displayed in a row or column depends on the Export Style you select on the Export dialog box.

**NOTE:** Data exported from a Line/Multiline chart is interpolated. This is because the data is interpreted by assuming that the line between two values is a straight line. All points along that line are estimated. The data shown on the chart is processed and not the raw representation. However, if your Line/Multiline chart uses Trend for its historical mode, the chart's raw values are exported instead of the interpolated data.
Working with Standard Charts

The following sections describe how to modify many of the properties of a Standard Chart:

- Working with Standard Chart Properties
- Defining General Standard Chart Properties
- Changing the Appearance of a Standard Chart
- Animating Standard Chart Properties
- Working in the Run-time Environment

Working with Standard Chart Properties

The Chart Configuration dialog box allows you to select and modify various properties for your charts. This dialog box contains two tabs: General and Chart. Properties selected from the General tabbed page apply to the entire chart. For example, you can enable run-time interaction in the entire chart (for zooming and pen selection, for example) by selecting the Highlightable and Selectable options.

Properties accessed from the Chart tabbed page, on the other hand, are applied per pen, unless you select the Apply to All Pens check box. The following section describes the methods of applying properties to your chart.

Applying Standard Chart Properties

There are several ways you can apply selected properties to your charts using the Chart Configuration dialog box:

- Select a new pen in the Pen List.
- Click OK.
- Click Apply.
- Select the Apply to All Pens check box.

Each of these methods are described in the following table.

<table>
<thead>
<tr>
<th>Methods of Applying Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Use this method...</strong></td>
</tr>
<tr>
<td>Select a new pen in the Pen List</td>
</tr>
</tbody>
</table>
Met hod of Applying Properties

<table>
<thead>
<tr>
<th>Use this method...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click OK</td>
<td>Quickly apply selected properties to your chart and close the Chart Configuration dialog box. No matter which method you use to apply properties, you must click OK to close the dialog box.</td>
</tr>
<tr>
<td>Click Apply</td>
<td>View a property change immediately without closing the Chart Configuration dialog box. For example, if you want to change the foreground color of a chart from gray to white, change the color and click Apply. The color of the chart will change while the Chart Configuration dialog box stays on your screen. You are not required to click Apply to apply properties to your chart.</td>
</tr>
<tr>
<td>Select the Apply to All Pens check box</td>
<td>Apply properties to all pens added to a chart. Refer to the Applying Properties to all Pens section below for more information.</td>
</tr>
</tbody>
</table>

Applying Properties to all Pens

iFIX allows you to easily define time, X and Y axis, grid, and legend properties for every pen you add to your chart. You can do this by simply selecting the Apply to All Pens check box on the Chart tabbed page. For example, you may want all of the pens in your chart to have the same legend. To accomplish this, click the Legend tab and select the properties you want. Next, select the Apply to All Pens check box. Exit the dialog box by clicking OK.

Defining the Pen Type

One of the most dynamic features of charts is the integration of both real-time and historical data in the same chart, which lets you easily view all types of data in the Proficy iFIX WorkSpace. You need to define a pen for each data source you want to trend. Before you can add a pen to your chart, however, you must specify a data source for that pen. The following sections show you how to select a data source and configure additional pen properties.

Adding Pens to Your Chart

Each pen that you enter must be defined by a data source. At the top of the Chart tabbed page of the Chart Configuration dialog box is the Data Source area, which lists the pen names in Data Server.NODE.TAG.FIELD format. By default, a sample pen is displayed in the pen list with the correct syntax you must use to address a data source.

There are two ways you can add a new pen to your chart:

1. Modify the existing sample pen by double-clicking it and entering the data source in the
Working with Standard Charts

2. Delete the existing sample pen by double-clicking it, highlighting it and pressing <Delete>,
and do one of the following:
   • Click the Add Pen button in the Pen List area, and enter a data source in the field that
     appears.
   • Double-click a blank field in the Pen list and enter a data source in the field.

You can also click the Browse button to the right of the field to display the Expression Builder, which
allows you to search for global data sources through a data source browser. To learn how to use the
Expression Builder and define data sources, refer to the Animating Object Properties chapter in the
Creating Pictures manual. For more information on data sources, refer to the System Architecture
section of the Understanding iFIX manual.

iFIX also gives you the ability to add pens to your chart in the run-time environment by writing a VBA
script. Refer to the Writing Scripts manual for more information.

**NOTE:** Whatever method you use to add pens to your charts, do not add more than 25 pens. Doing so
may cause your chart to disappear.

To modify an existing pen in the pen list, double-click the pen and enter an alternate data source. To
change the order of the pens in the chart’s legend, click the pen you want to move in the Pen List area,
and then click either the up or down arrow.

To delete a pen, double-click the pen from the list and click the Delete button.

Defining Data Properties

To control how the data is presented by the configured pen(s), you can define data properties for each
pen in your chart. You can do this by simply selecting the properties you want on the Chart tabbed
page. The following properties can be defined:

- **High Limit** – Displays the high limit value defined for the selected data source.
- **Low Limit** – Displays the low limit value defined for the selected data source.
- **Fetch Limits** – At run-time, automatically retrieves the low and high limits assigned to the...
selected data source.

- **Maximum Display Points** – Determines how many data points will be displayed in the chart over a given span duration.
- **Show Line** – Displays the trend line for the selected data source.
- **Constant Line** – Displays a constant horizontal line at the current value of the pen.
- **Show Gaps** – Determines whether a blank space or a line is displayed to represent an area in a plot where there is no data.

The following table illustrates some examples of data properties applied to a chart.

<table>
<thead>
<tr>
<th>Data Property Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Use this property...</strong></td>
</tr>
<tr>
<td>High Limit</td>
</tr>
<tr>
<td>Fetch Limits</td>
</tr>
<tr>
<td>Maximum Display Points</td>
</tr>
</tbody>
</table>

**Selecting a Historical Display Mode**

Pens displaying historical data offer additional flexibility in how the data is displayed by offering a *historical mode*, available on the Pen tab of the Chart Configuration dialog box. Select a mode from the Historical Mode drop-down list. The display mode determines how iFIX selects data from a historical data source and displays it in the chart, and determines what each displayed value represents.

Historical modes are directly related to Span Interval and Span Duration properties for the time group. The Span Interval determines the range of data that the display mode uses to calculate the point of data that is trended. Time group properties are further described in the Defining Time Ranges section.

The following table shows the different historical modes you can choose from, and how trending differs for each mode.
## Historical Modes

<table>
<thead>
<tr>
<th>If you select this mode...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample</td>
<td>The last valid value found is trended, up to and including the start of the interval.</td>
</tr>
<tr>
<td>Avg</td>
<td>The average of all valid data found during the interval is trended, starting at the beginning of the interval, 12:00:00.</td>
</tr>
<tr>
<td>High</td>
<td>The highest valid data point value found during the interval is trended, starting at the beginning of the interval, 12:00:00</td>
</tr>
<tr>
<td>Interpolated</td>
<td>The data is interpreted by assuming that the line between two values is a straight line. All points along that line are estimated except the starting point and the ending point. Available for Proficy Historian only.</td>
</tr>
</tbody>
</table>

Let's examine an example of a pen configured to display in sample mode. Assume that the following data is available for a pen and the Interval is set to 10 minutes.

<table>
<thead>
<tr>
<th>Time</th>
<th>Data Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>12:00:00</td>
<td>0.0</td>
</tr>
<tr>
<td>12:01:00</td>
<td>1.00</td>
</tr>
<tr>
<td>12:02:00</td>
<td>2.00</td>
</tr>
<tr>
<td>12:03:00</td>
<td>3.00</td>
</tr>
<tr>
<td>12:04:00</td>
<td>4.00</td>
</tr>
<tr>
<td>12:05:00</td>
<td>5.00</td>
</tr>
<tr>
<td>12:06:00</td>
<td>6.00</td>
</tr>
<tr>
<td>12:07:00</td>
<td>7.00</td>
</tr>
</tbody>
</table>
Using the above chart, the values are trended as indicated:

**Avg** – 4.5 is trended from 12:00:00 to 12:10:00.

**High** – 9.0 is trended from 12:00:00 to 12:10:00.

**Low** – 0.0 is trended from 12:00:00 to 12:10:00.

The value, 0.0 at 12:00:00 (the start of the interval), is trended for the duration of the interval, from 12:00:00 up to 12:10:00. If 0.0 is not a valid point, then the last valid value found prior to the start of the interval is trended.

You can enter a data source more than once to display data in different modes. For example, if you trend an Analog Input block, you can enter the block twice in the Pens list box: once in Sample mode, and again in Average mode.

*NOTE:* Sample mode is the fastest mode for displaying historical data. However, the average, high, and low modes may provide more detailed data values for your application.

---

**Defining General Standard Chart Properties**

The General tab on the Chart Configuration dialog box lets you specify basic chart properties such as a title and color, as well as scroll and display options. Properties selected from the General tab apply to the entire chart.

The following sections describe these properties:

- Naming a Chart
- Entering a Chart Description
- Attributing a Help Context ID
- Scrolling a Chart

**Naming a Standard Chart**

The Name field allows you to enter a specific name for your chart. When you initially add a chart to your picture, the default name appears as *Chart1*. To change the name, enter an alternate name in the Name field.
**Entering a Standard Chart Description**

The Description field allows you add a description for your chart. This can be any name that will help you identify the purpose of the chart.

**Attributing a Help Context ID**

If you have created your own help files, you can attribute a help context ID by entering a value in the Help Context ID field. When you switch to the run-time environment, you can select the chart and press F1 to get help on the chart.

For more information on creating help files, refer to the Creating the Help File section of the Mastering iFIX manual.

**Scrolling a Standard Chart**

The first thing you must do in order to scroll a chart is determine the direction of the scroll. The scroll direction determines whether the data on the chart plots left-to-right or right-to-left. You can specify a scroll direction for the chart by selecting the appropriate option button in the Scroll Direction area of the General tabbed page.

The following figure illustrates a chart configured with both a real-time and historical pen, with a right-to-left scroll.

![Chart Illustration]
Trending Historical Data

For a left-to-right scroll, you can also assign a reset value by entering a value in the Reset field. When the data plot reaches the right edge of the chart, a reset occurs and the pen fetches new data. The data and its time shifts according to the reset percentage. For example, if you enter a reset value of 50, the data plot will shift back one-half of the chart's time axis when it hits the right edge.

To scroll the chart, use the Historical Dynamo, available in the Dynamo Sets folder in the Proficy iFIX WorkSpace system tree. To use the Historical Dynamo, add the Dynamo to your picture and double-click it. The Chart Configuration dialog box appears, which lets you make changes to the chart's properties. Click the Left and Right arrows on the bottom-left and bottom-right of the chart to scroll the chart in a particular direction.

NOTE: The Quick Dynamo Updater and Dynamo Updater Wizard are not available for the Chart Dynamo, and other pre-canned Dynamos that were available before iFIX 4.5. This is because they are not true Dynamo objects.

You can also configure AutoUpdate to scroll the chart forward automatically.

You can change the chart's scroll percentage using VBA scripts. For more information on using scripts to scroll charts, refer to the Writing Scripts manual.

Plotting Ideal Curves

A chart's left-to-right scrolling functionality helps you easily determine how close your data is to a desired value. It does so by letting you easily recognize ideal and actual curves in the same chart. An ideal curve is an existing historical plot that represents an ideal condition in your process. The actual curve is a real-time plot that represents current conditions. Depending on your process, it may be crucial that the actual curve come as close as possible, if not exactly match, the ideal curve.

For example, let's say you want to plot real-time data so that it shows the proper variation in temperature of a process, determined by a plot collected previously. Using multiple pens and scrolling in iFIX charts, you can view the real-time and historical data simultaneously to determine whether data that is currently being fetched matches the ideal scenario.

First, configure both a real-time and a historical pen. Then, for example, assign a green color property for the real-time pen, and a red color property for the historical pen. Then specify a left-to-right scroll with a reset value of 50. When you switch to the run-time environment, you can watch the real-time pen follow the ideal curve. When the data reaches the right edge of the chart, the data is reset and the plot resumes in the middle of the graph. You do not have to manually position, change the shape of the chart, or leave the run-time environment.

Thanks to the real-time monitoring of all types of data in a scrollable format, iFIX charts give you the ability to monitor crucial fluctuations in data which, in many cases, can greatly impact your process. The following figure illustrates a chart plotting both a real-time and historical pen with a left-to-right scroll. Notice how easy it is to evaluate the ideal curve.
Scroll direction also appears in the Chart Preferences tabbed page of the User Preferences dialog box. If you change the scroll direction in Chart Preferences, you change the default value for all new charts. To access this dialog box, select User Preferences from the WorkSpace menu (Classic view) or on the Home tab, in the WorkSpace group, in the Settings list, click User Preferences (Ribbon view), and click the Chart Preferences tab. For more information on the User Preferences dialog box, refer to the Setting User Preferences section of the Understanding iFIX manual.

Changing the Appearance of a Standard Chart

You can easily change how a chart looks by selecting specific properties in the Chart Configuration dialog box. These can include attributes such as color, refresh rate, and transparency, or pen styles such as a marker type.

The following sections describe how to change the appearance of a chart by modifying many of the available chart and pen properties:

- Changing a Chart's Foreground or Background Colors
- Changing the Refresh Rate
- Defining Pen Styles
- Defining Time Ranges
Trending Historical Data

- Configuring the X and Y Axis
- Defining a Grid
- Configuring the Legend

Changing a Standard Chart's Foreground or Background Colors

A chart object is comprised of two rectangular areas: the chart area (where the trends are drawn), and the area around the chart. You can select or change the color of the foreground or background colors using the General tab on the Chart Configuration dialog box. To do this, click either the Foreground Color or Background Color field in the Appearance area and select a color from the Select Color dialog box.

We offer the following recommendations for choosing your colors:

- Use darker colors for the background and a lighter color for the foreground, so that the chart data in the foreground is easier to read.
- Apply a dark pen line color that contrasts well with yellow, so that you can easily read the data on a tool tip in the run-time environment. (The tool tip appears as a yellow box.) Refer to the Displaying Time Cursors and Tool Tips section for information on the tool tip feature.
- Create a transparent chart. The following section shows you how to apply the transparency property to your chart.

For more information on this dialog box and the different ways you can color objects, refer to the Working with Color section in the Creating Pictures manual.

Making the Chart Transparent

A transparent chart is clear, allowing objects displayed behind the chart to be visible. By clicking the Transparent check box in the Appearance area, you instantly create a gray-on-white transparent chart, with a red legend, X and Y axes, data source, and description. The figure that follows illustrates a transparent chart.

The Transparency property also appears in the Chart Preferences tabbed page of the User Preferences.
dialog box. To enable or disable the Transparency property for all new charts, select or deselect the
Transparent check box. To access the Chart Preferences dialog box, select User Preferences from the
WorkSpace menu (Classic view) or on the Home tab, in the WorkSpace group, in the Settings list,
click User Preferences (Ribbon view), and click the Chart Preferences tab.

Changing the Refresh Rate

The refresh rate determines how quickly a chart updates the data plot in the run-time environment. The
faster the refresh rate, the slower your performance will be, as the chart needs to be redrawn each time
it is refreshed at the specified refresh rate.

You can specify a refresh rate for your chart by entering a rate, in seconds, in the Refresh Rate field.
The refresh rate can be from 0.1 seconds to a maximum of 1800 seconds, and can be entered in 0.1
second intervals.

Defining Pen Styles

iFIX lets you determine how the pens in your chart look, giving you complete control over the
appearance of your chart. On the Pen tabbed page of the Chart Configuration dialog box, you can
define the following pen styles:

- **Line Style** – Applies a style to the pen's plot line.
- **Line Color** – Applies a color to the pen's plot line.
- **Line Width** – Specifies the width of a pen's plot line.
- **Marker Style** – Applies a style to the pen's marker type.

Each of these styles are described in the following sections.

Applying Line Styles

With iFIX, you can use any line style that you use in any other object. To apply a line style, simple
select it from the Line Style drop-down list. Available line styles are:

- **Solid** – Applies a solid pen line style.
- **Dash** – Applies a dashed pen line style.
- **Dot** – Applies a dotted pen line style.
- **DashDot** – Applies a dash-dot combination line style.
- **DashDotDot** – Applies a dash-dot-dot combination line style.

The following figure illustrates each of these line styles in a chart.
Selecting a Line Color

To select a line color for a pen, click the Line Color field and choose a color from the Select Color dialog box. Line colors also apply to the X and Y axis and to the legend. For more information on using this dialog box, refer to the Working with Color section of the Creating Pictures manual.

Selecting a Marker Style

In the Marker Style field, you can select a shape or character to represent the pen marker in your chart. Markers are particularly useful for printing to a black and white printer. Using the drop-down menu, you can select from the following marker styles:

- **None** – Applies a solid line marker to the pen.
- **Rectangle** – Applies a rectangle marker to the pen.
- **Oval** – Applies an oval marker to the pen.
- **Diamond** – Applies a diamond marker to the pen.
- **Character** – Applies a character to represent a pen marker. If you select this option, the character field to the right of the Marker Style drop-down list is enabled. Enter any alphanumeric keyboard character in the field.

Defining Time Ranges

Using the Time tab of the Chart Configuration dialog box, you can assign a time range to each pen in the chart. This allows you to compare data from different time periods on the same chart, which in turn aides in plotting ideal curves versus actual curves. You can specify one global time period for all pens in a chart, or select a separate time period for each pen.
To define time ranges, click the Time tab and enter the time ranges in the appropriate fields on the Time tabbed page. Refer to the following table for the correct entry and format for each field.

<table>
<thead>
<tr>
<th>In the field...</th>
<th>Enter...</th>
<th>In the format...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fixed Date</td>
<td>A specific date on which to start the display.</td>
<td>MM/DD/YYYY (month/day/year)</td>
</tr>
<tr>
<td>Days Before Now</td>
<td>The number of days prior to today to start the display. For example, if you want to define a time group to display data collected two days before the current date, enter 2.</td>
<td>999 (maximum value)</td>
</tr>
<tr>
<td>Fixed Time</td>
<td>A specific time to start the display, based on a 24-hour clock. For example, enter 14:00:00 for a starting time of 2 P.M.</td>
<td>HH:MM:SS (hour:minutes:seconds)</td>
</tr>
<tr>
<td>Lock Time</td>
<td>Locks the current time, even if you change the time zone in the Date and Time Properties dialog box in the Control Panel. This field is only available when you designate a specific time to start the display using the Fixed Time field.</td>
<td></td>
</tr>
<tr>
<td>Duration Before Now</td>
<td>The duration prior to the current time to start the display. The minimum duration for a display is 0 seconds; the maximum is 23 hours, 59 minutes, and 59 seconds.</td>
<td>HH:MM:SS</td>
</tr>
<tr>
<td>Time Zone</td>
<td>The time zone to associate with the start time. You can select an explicit time zone, the client time zone, the server time zone, or the tag time zone. The default time zone is that of the client machine. This field is only available when Proficy Historian is being used.</td>
<td></td>
</tr>
</tbody>
</table>
### Time Range Fields and Formats

<table>
<thead>
<tr>
<th>In the field...</th>
<th>Enter...</th>
<th>In the format...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Adjust for Daylight Savings Time</strong></td>
<td>Adjusts the time when the zone you selected is experiencing daylight saving if you selected the Automatically adjust clock for daylight saving changes check box in the Control Panel. This field is only available when Proficy Historian is being used. *NOTE: Before allowing automatic Daylight Saving Time to be used in a production environment, you should test your application for proper behavior.</td>
<td>Days: DD&lt;br&gt;Time: HH:MM:SS</td>
</tr>
<tr>
<td><strong>Duration</strong></td>
<td>The duration for the display, which determines how much data to display on the X axis. The minimum duration for a display is 1 second; the maximum is 99 days, 23 hours, 59 minutes, and 59 seconds. Using Proficy Historian, the minimum duration for a display is 1 second; the maximum is 999 days, 23 hours, 59 minutes, and 59 seconds. The span duration also appears in the Chart Preferences tabbed page of the User Preferences dialog box. *NOTE: The Duration must be evenly divisible by the Interval or unpredictable results may occur in the chart. The Chart tab does not allow you to configure a duration that is not evenly divisible by the Interval.</td>
<td></td>
</tr>
</tbody>
</table>
Time Range Fields and Formats

<table>
<thead>
<tr>
<th>In the field...</th>
<th>Enter...</th>
<th>In the format...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Span Interval</td>
<td>A time interval between the samples taken from the Historical Collect data file. The interval cannot be greater than half the Duration value. When the Span Interval is 0, the time interval between data samplings is determined automatically based on the span duration divided by the maximum number of display points. The span duration also appears in the Chart Preferences tabbed page of the User Preferences dialog box. You can display milliseconds only if you are using Proficy Historian. <strong>NOTE:</strong> The Span Duration must be evenly divisible by the Span Interval. Configuring a Span Duration that is not evenly divisible by the Span Interval can cause unpredictable results in the chart.</td>
<td>Time: HH:MM:SS</td>
</tr>
</tbody>
</table>

You can also dynamically change the limits of the time axis using a VBA script that changes in the Start Time and End Time properties of a chart. To enable this feature, select the Allow Reset of Axis Limits check box on the X-Axis tab. When you select this control, you enable the time axis to be reset after you right-click to zoom out in a chart. If you want to configure all charts to behave this way, select the Allow Time Axis Reset check box in the WorkSpace's user preferences.

To apply a global time period to all pens in a chart, select the Apply to All Pens check box. For more information on applying properties to all pens, refer to the Applying Properties to all Pens section.

**Configuring the X and Y Axis**

iFIX charts allow you to configure both the X (horizontal) and Y (vertical) axis so that you can customize your display. For example, let's say you want to plot an Analog Input block, AI1, with values ranging from 0 to 100 with a one-minute duration (represented as a red pen line with a rectangle marker). You also want to plot another Analog Input block, AI2, with values from 0 to 200 with a two-minute duration (represented as a blue pen line with an oval marker). You can view both plots at the same time and, if the chart is selectable, you can switch between pens by either clicking the plot line or by clicking the text in the legend. This is illustrated in the following figure.
You can configure an axis by clicking the X-axis or Y-axis tab. On both tabs you can choose whether
to display the axis or axis labels, and you can specify the title name, the axis color, and the number of
labels and ticks. For the X axis, you can also select whether to display the date.

To specify a title name, enter a title of up to 255 characters in the Title field. To specify a color, click
the Label Color field and select a color from the Select Color dialog box.

To specify the number of labels in your chart, enter a number in the Number of Labels field. The
maximum number of labels you can have is 21. Similarly, to specify the number of ticks per axis, enter
a number in the Number of Ticks field. The maximum number of ticks you can have is 21.

The default values for ticks and labels appears in the Chart Preferences tabbed page of the User
Preferences dialog box.

**Defining a Grid**

The grid in your chart gives you a point of reference when data points move across the chart. iFIX
gives you precise control of both the horizontal and vertical axis of your grid. To define a grid, click
the Grid tab. Both the Show Horizontal Grid and Show Vertical Grid areas let you select whether to
display the grid, the number of lines in the grid, and the grid color and style. For the horizontal axis,
you can also select whether to scroll the grid when you select a scrolling option.

To select a number of lines for the grid, enter a number in the Number of Lines field. The maximum
number of lines you can have in your grid is 21. To select a color for your grid, click the Grid Color
field and select a color from the Select Color dialog box.

To select a grid style, select a style from the Grid Style drop-down list. You have the same types of styles for your grid as you do for your pen line styles (Solid, Dashed, Dotted, Dash-Dot, and Dash-Dot-Dot).

Configuring the Legend

The legend lets you quickly identify the information that the chart is plotting. The legend appears at the bottom of the chart and provides collection and error information for each trended data source. Each legend displays in the pen color assigned to the pen's data source. To configure a legend, click the Legend tab on the Chart tabbed page of the Chart Configuration dialog box.

You can modify the legend to appear in various configurations. For example, if you want to change the length of the data source description, select the Description check box in the Items area and enter the number of characters that represents the length of the description. To change the order of the pens in the chart's legend, click the pen you want to move in the Pen List area, and then click either the up or down arrow.

To configure the legend, click the Legend tab and select or deselect the properties of the legend. The Order area of the Legend tab lets you display the items you select in any order in the legend (left to right).

Animating Chart Properties

Chart properties can be animated just like other iFIX objects. For example, you can animate the chart's foreground color, pen color, and value axis. To animate chart properties, right-click the chart and select Animations from the pop-up menu. The Animation dialog box lets you change property settings and add animations to those properties. For more information on animating object properties, refer to the Animating Object Properties chapter of the Creating Pictures manual.

Working in the Run-time Environment

To view the data in a chart, click the Switch to Run button on the Standard toolbar (Classic view) or on the Home tab, in the WorkSpace group, click Switch to Run (Ribbon view). In order to control your charts in the run-time environment, you must assign specific attributes in the configuration environment.

These attributes are detailed in the following sections:

- Defining Run-time Attributes
- Zooming
- Displaying Multiple Values and Times
- Displaying Time Cursors and Tool Tips
- Understanding Chart Time
- Adjusting for Daylight Saving Time
Defining Run-time Attributes

You can assign certain attributes in the configuration environment to make the chart accessible when you switch to the run-time environment. You can specify these attributes by selecting the appropriate check boxes on the General tabbed page of the Chart Configuration dialog box. Refer to the following table:

<table>
<thead>
<tr>
<th>Chart Attributes</th>
<th>By selecting the check box...</th>
<th>You activate the property...</th>
<th>Which lets you...</th>
</tr>
</thead>
</table>
| Highlightable    |                               | IsControllable              | Highlight the object at run-time so it can be modified.  
Example: Determine which object in a picture can be selected or modified. |
| Selectable       |                               | IsSelectable                | Select the object at run-time.  
Examples: Zoom in on an area of the chart; display a time cursor tool tip on a pen. |
| Modifiable       |                               | IsModifiable                | Modify the object at run-time.  
Example: Modify pen properties using the Chart Configuration dialog box. |

Zooming

When a chart is selectable, you can zoom to an area of the chart by placing the cursor within the chart area and clicking an area, or enclosing an area in a rectangle selector. When the cursor is in the chart area, it becomes a magnifying glass. You can zoom to the horizontal, vertical, or both axes in the chart to view specific data. To zoom out on the chart, right-click the mouse while the cursor is in the chart area.

Depending on the options you enabled, the chart is restored to its original magnification or to the magnification set by the HiLimit and LoLimit properties (on the Y-axis) and the Start Time and End Time properties (on the X-axis). The following table summarizes the options to set or clear to achieve the effect you want.
To... | Do this...
---|---
Restore the chart to its original magnification. | Clear the following check boxes:
• Allow Reset of Axis Limits (on the x-axis and y-axis tabs of the Chart object).
• Allow Time Axis Reset (on the Chart Preferences tab of the User Preferences dialog box).
• Allow Value Axis Reset (on the Chart Preferences tab of the User Preferences dialog box).

Reset the range of the time axis to the Start Time and End Time properties. | Select one of the following check boxes:
• The Allow Reset of Axis Limits check box (on the x-axis tab of the Chart object).
• The Allow Time Axis Reset check box on the Chart Preferences tab of the User Preferences dialog box.

Reset the range of the value axis to the HiLimit and LoLimit properties. | Select one of the following check boxes:
• The Allow Reset of Axis Limits check box (on the y-axis tab of the Chart object).
• The Allow Value Axis Reset check box on the Chart Preferences tab of the User Preferences dialog box.

**Displaying Multiple Values and Times**

In your chart, you may have pens with different high and low limits and time scales. You may want to see these differences in the run-time environment. By default, iFIX lets you view a given pen's value and time axis by clicking the pen line, clicking the pen's legend, or setting the current pen using VBA scripts.

If you don't need to view the value of a specific pen, select the Show Multiple Values check box on the General tabbed page. The chart will be displayed with all of the pen's axes in a stacked fashion. Similarly, if you wish to view specific time scales for your pens, deselect the Show Multiple Times check box. To view multiple time scales, select the Show Multiple Times check box.

The following figure illustrates a chart with two pens configured with different time and value ranges and their axes.
Displaying Time Cursors and Tool Tips

In iFIX you can choose to display time cursors in the run-time environment. The time cursor appears as a gray bar in the center of the chart that you move left and right by clicking the cursor and dragging it with the mouse. The value of the time cursor is displayed in the legend. For historical pens, the value at the point of the time cursor is displayed; for real-time pens, the current value is always displayed. To display the time cursor in the run-time environment, select the Show Time Cursor check box on the General tabbed page.

Another run-time feature of charts is the time cursor tool tip. When you click on a point in a pen line where that line crosses the time cursor, the current time and value of that point is displayed in a yellow-colored box. The tool tip is a convenient way to determine plot values in the run-time environment. Every pen in the chart has its own tool tip. To display the tool tip in the run-time environment, select the Show Time Cursor ToolTips check box on the General tabbed page.

**NOTE:** The chart must be selectable to view the time cursor and tool tip at run-time.

The following figure illustrates a chart configured with two real-time pens, a time cursor, and tool tip for each pen.
Understanding Standard Chart Time

The following fields affect the time displayed in the chart when you use a fixed start time and date:

- Lock Time
- Time Zone (Proficy Historian only)
- Adjust for Daylight Savings Time (Proficy Historian only)

iFIX charts save time as *Coordinated Universal Time* (or *UTC time*). When you switch to the run-time environment, UTC time is read from the picture file containing the chart, and is then converted to local time before the chart fetches data from the historical file. Therefore, when you configure a chart, time is entered and displayed in local time. However, the time saved *within* the chart is in UTC time, which allows the data to be displayed independently of specific time zones.

The following examples help explain the concept of using time zones and daylight saving.

**Example 1: No Features Enabled**

In this example, pictures are created and saved in Eastern Standard Time (EST). The Fixed Time is set to 09:00:00, the Duration Before Now is set to 01:00:00, and Days Before now is set to 0. You get these results when you open the picture in the indicated time zone:

**EST** – displays data from 9:00 to 10:00 a.m.
CST – displays data from 8:00 a.m. to 9:00 a.m. local time.

Example 2: Lock Time Feature is Enabled

In this example, pictures are created and saved in EST. The Fixed Time is set to 09:00:00, the Lock Time is selected, the Duration Before Now is set to 01:00:00, and Days Before now is set to 0. You get these results when you open the picture in the indicated time zone:

EST – displays data from 9:00 to 10:00 a.m. local time.

CST – displays data from 9:00 a.m. to 10:00 a.m. local time.

Example 3: Developing for Remote Deployment (Proficy Historian only)

When you use the Time Zone and Adjust for Daylight Savings Time fields, the pictures you create are independent of the time zone in which you draw them. This independence gives you more control of the behavior of a picture when it is opened.

In this example, pictures are created and saved in EST, but deployed to a computer in Pacific Standard Time (PST). If you want the picture to show 9:00 a.m. to 10:00 a.m. PST when opened, you must select the explicit PST time zone in the Chart tab and set the start time to 9:00 a.m. You must also select Lock Time check box.

If your plant policy is to automatically adjust for Daylight Saving Time and you have selected Automatically Adjust for DST in the Control Panel time settings, then you should select the Adjust for Daylight Savings Time check box in Chart tab.

Example 4: Developing for Multiple Time Zone Deployment (Proficy Historian only)

You can share pictures across time zones by using the client time zone setting in the Chart tab.

In this example, pictures are created and saved in EST, but deployed to a computer in EST in the client time zone. The Lock Time is selected. When the picture is opened in CST, PST, or EST, it is always displayed as 9:00 a.m. local time.

Example 5: Using Server Time Zone (Proficy Historian only)

A picture configured to use the server time zone can be opened on any client machine in any time zone and will always show the same plot of data.

Example 6: Displaying Data from Other Time Zones (Proficy Historian only)

You are investigating an event that occurred at 3:30 Central Standard Time (CST) and your computer is in PST. Rather than open a chart with a 1:30 start time in PST, you can select the explicit central time from the Time Zone field and set the Fixed Time at 3:30.

Example 7: Displaying Data from Multiple Time Zones (Proficy Historian only)

You have some points in the Proficy Historian archive that contain data from Mountain Standard Time (MST) and some from PST. You want to create a chart to display the events that occurred in each time zone at 10:00 a.m. Rather than being required to know the exact time zone location of each point and then choosing explicit time zones, you can select the tag time in the Time Zone field and set the Fixed
Time at 10:00 a.m.

The UTC time feature of iFIX charts allows you to easily view and analyze a data plot, no matter where you display the data.

**Adjusting for Daylight Saving Time**

If you are a Proficy Historian user, you have the option to adjust for daylight saving time. If you choose to adjust for daylight saving time, you must:

1. Select the Automatically adjust clock for daylight saving changes check box in the Date/Time section of the Control Panel on all Proficy Historian collector, Proficy Historian server, and iFIX client computers.
2. Select the Adjust for Daylight Savings Time check box on the Time tab when you add an historical pen to an iFIX chart.

Before allowing automatic Daylight Saving Time to be used in a production environment, you should test your application under each of the following scenarios for proper behavior:

- While in Standard Time.
- While in Daylight Time.
- During the transition from Standard Time to Daylight Time.
- During the transition from Daylight Time to Standard Time.
Using the Chart Group Wizard with Standard Charts

The Chart Group Wizard™ is designed for users who create or work with charts to monitor processes. The Chart Group Wizard offers you a flexible approach to charting data. You can use the Chart Group Wizard to design and save multiple pen configurations in a chart group file. Operators can apply a saved chart group file to a chart and track its data, and then apply a different chart group file to the same chart and track different data. The Chart Group Wizard eliminates the need to clutter a picture with multiple chart objects and re-configure pen definitions to monitor different data.

For example, a manufacturing process may have these three process types:

- Temperature-sensitive
- Flow-dependent
- Fill-dependent

Using the Chart Group Wizard, you might create these chart group files to accommodate this manufacturing process: one that defines pens that track real-time and historical temperature-related data; one that tracks flow-related data; and one that tracks fill-related data. You need only one chart to display the data configured for each chart group file. You apply a chart group file to the chart to display its data, and you then apply a different chart group file to monitor different data.

Displaying and Using the Chart Group Toolbar

Before using the Chart Group Wizard, you must import the Chart Group toolbar from the WorkSpace, if it is not already visible in the WorkSpace.

**NOTE:** Although hidden by default, you can access and use toolbars in Ribbon view. To access a toolbar in Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click Toolbars.

To display the Chart Group toolbar:

1. In the WorkSpace system tree, double-click the Project Toolbar Files folder, and then the Toolbars folder.
2. Double-click the ChartGroupToolbar item to display the toolbar. The Chart Group toolbar should now display in the WorkSpace.

After importing the toolbar, the Chart Group Toolbar appears when you open a picture. The toolbar contains the three buttons shown in the following figure.
The following table describes the purpose of each button on the Chart Group toolbar.

<table>
<thead>
<tr>
<th>Use this button...</th>
<th>Which can be accessed in Ribbon view...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apply Chart Group Wizard To Chart</td>
<td>From the Tools tab, in the Charts group, click Chart Groups.</td>
<td>Apply or remove the ability to use the Wizard on selected charts in run mode.</td>
</tr>
<tr>
<td>Apply Chart Group File</td>
<td>From the Tools tab, in the Charts group, click Chart Groups.</td>
<td>Apply a default chart group file to a chart when a picture opens on an object's Click event.</td>
</tr>
<tr>
<td>Configure Chart Group Files</td>
<td>From the Tools tab, in the Charts group, click Chart Groups.</td>
<td>Invoke the Chart Group Wizard that you use to work with chart group files in configuration and run mode.</td>
</tr>
</tbody>
</table>

**Before You Begin Working with the Chart Group Wizard**

This section provides information you need to know before working with the Chart Group Wizard. In this section you'll learn about charts and pens and chart group files. You'll also be introduced to the demonstration picture available to you when you import the Chart Group Wizard.

Refer to the following topics for more details:

- Understanding Charts and Pens
- Understanding Chart Group Files
- Analyzing the Demonstration Picture
Understanding Charts and Pens

You must understand the concept and use of charts and pens to fully understand how to effectively use the Chart Group Wizard. A chart is an object that lets you display real-time and historical data. iFIX charts are multi-pen; they allow you to configure multiple pens in one chart to plot different data trends. Each pen is defined by its data source and can be uniquely configured to draw a trend line with its own color, line style, time range, marker style, and data limits.

A pen can plot three types of data:

- Real-time
- Historical
- T-data (data obtained from a trend block of a real-time data source)

The type of data you plot determines the pen type, which determines the appropriate properties for the pen. For example, the Days Before Now property is appropriate for an Historical pen, but is not appropriate for a real-time pen.

For more complete information on charts and pens, refer to the Using Charts to Analyze Process Trends chapter.

Understanding Chart Group Files

A chart group file is a collection of pens configured in the Chart Group Wizard. When you use a chart group file, you save your pen configurations as .CSV files in the C:\Program Files\Proficy\Proficy iFIX\HTR subdirectory. Each pen has its own data source and configurations, such as color, line style, and limits. You can create a chart group file independently of a chart. You can extract pen configurations from existing charts and create a chart group file from that configuration.

You can use chart group files in both configuration and run mode. In configuration mode, you can:

- Create, open, delete, and save chart group files.
- Apply a chart group file to a chart when a picture opens or when you click an object.
- Apply options that determine which functionality is available to you in run mode.

You can perform the same actions in run mode as in configuration mode. You can additionally perform these actions in run mode:

- Apply or associate a chart group file with a chart.
- Apply a chart group configuration to a chart without associating a chart group file with the chart.

You can open chart group files in other applications, such as Microsoft Excel™, to view and modify the file contents.

Analyzing the Demonstration Picture

When you import the Chart Group Wizard, the demonstration picture ChartGroupDemo.grf appears under the Pictures folder in the WorkSpace System Tree. This picture is provided to help you gain a better understanding of working with the Chart Group Wizard.
Before you use this picture, you must enable the Local Node Alias in the System Configuration setup.

**To enable the Local Node Alias:**

1. Ensure that you are logged in as an Administrator.
2. Open the System Control Utility (SCU).
3. On the Configure menu, click Local Startup. The Local Startup Definition dialog box appears.
4. Click the Local Node Alias check box.
5. Click OK.

Once you've enabled the Local Node alias, you can open the demo picture by double-clicking the ChartGroupDemo, located in the Pictures system tree of the WorkSpace. The picture contains two charts, Chart1 and Chart2. These charts are provided in the demonstration picture to illustrate the versatility of using the Chart Group Wizard in run mode.

Use the following chart group files, located in the C:\Program Files\Proficy\Proficy iFIX\HTR directory, with Chart1 and Chart2:

- **ChartGroup1.csv** – plots data from nine data sources.
- **ChartGroup2.csv** – plots data from four data sources.
- **ChartGroup3.csv** – plots data from two data sources.

Each of these chart group files contains different pen configurations and varying high limits and fetch pen limits. The data sources for each are displayed when you apply a file to a chart.

**Using the Demonstration Picture in Run Mode**

In run mode, you can double-click Chart1 to invoke the Chart Group File dialog box, from which you can create a new chart group file or open and modify existing ones, such as ChartGroup1.csv.

Chart2 does not have the Chart Group Wizard applied to it, which prevents you from selecting a chart group file to apply to the chart. However, you can apply a chart group file to Chart2 by clicking one of the three command buttons. The Click event of each command button is configured to use an exposed Chart Group Wizard method (CGW_ApplyFileToChart) to apply a specific chart group file to Chart2. The command buttons use ChartGroup1.csv, ChartGroup2.csv, and ChartGroup3.csv, respectively.

**Defining Pens in a Chart Group File**

To define a pen, you should know how to use the Expression Builder, understand what data sources are, and know how to define them. Refer to the following sections for more details:

- Adding, Modifying, Deleting, and Re-Ordering Pens
- Setting Pen Styles
- Setting Pen Properties
- Historical Mode Options
Applying Changed Pen Configurations to a Chart

For additional information, refer to the Creating Pictures and Understanding iFIX manuals.

Adding, Modifying, Deleting, and Re-Ordering Pens

The Pen List area displays the pen data sources. Use the four buttons on the Pen toolbar to add, delete, and re-order the pen sequence in the list box. The Pen toolbar is shown in the following figure.

![Pen Toolbar](image)

Adding and Editing Pens

To add a pen, you can perform any one of these actions:

- Click the Add button.
- Double-click directly below the last pen in the Pen list.

To clear all pens from the Pen List before adding new pens, click New. If you have already modified the existing pens, the Chart Group Wizard prompts you to save your changes before it clears the Pen List. Double-click an existing pen to modify its data source.

The Expression Builder appears each time you add a pen. Click the down arrow to display a drop-down list of the ten most-recently defined pens in your iFIX system. Click the Browse button to select a new data source for the pen.

Deleting Pens

You can delete a pen, as long as at least one pen remains defined to a chart group file. If the file contains only one pen, re-configure the pen or delete the file if the you no longer need the information.

To delete a pen from a Pen List, select the pen and then click the Delete button, located above the Pen List.

The Chart Group Wizard does not prompt you to verify that you want to delete the pen; it removes the pen from the Pen List. If you decide not to delete the pen, close the Chart Group Configuration dialog box without saving your changes.

Reordering Pens

The order of the pens in the Pen List determines the order of pens listed in the chart key and the default
Trending Historical Data

labels that appear on the X-axis and Y-axis of the chart in run mode.

After adding two or more pens to a chart group file, you may want to change the order of the pens in the Pen List. To change the order of a pen in the Pen List, select the pen and then click the Up arrow to move it up in the list or the Down arrow to move it down.

**Setting Pen Styles**

You can set individual line styles to distinguish each pen in your chart. The Pen Style area in the Configure Chart Group dialog box contains these properties:

- **Line Style** - determines what type of line to display, such as solid, dashed, or dotted. To choose a line style, select one from the drop-down list box.

- **Line Color** - sets a color for the line. To select a color, click the Line Color field and select a color from the Select Color dialog box. These colors also apply to the X- and Y-axis and legends in the chart.

- **Marker Style** - sets a shape or character that represents the pen marker in your chart. Markers are convenient for discerning shapes and characters if you print your charts on a non-color printer. To select a marker, choose one from the drop-down list box. If you choose the Character option, enter a character in the Marker Character field.

- **Line Width** - sets the width of the pen's plot line. The default line width is 1.

**Setting Pen Properties**

Once you add pens to the chart group file, you can set individual properties for each pen. For historical pens, you can also select an option to use common time settings for each pen.

**Setting Time-Related Pen Properties**

The Time area of the Chart Group Configuration dialog box sets time-related properties for the selected pen. These properties depend of the type of pen: Real-time or Historical.

The Duration pen property is the only property that you can set for Real-time pens. It also applies to historical pens and is used by the Historical Mode property. The Duration property sets the time duration for the chart. Enter a duration value in this format:

```
 dd:hh:mm:ss
```

For historical pens, you can assign a time range to each pen or specify one global time period. Applying different time ranges to the pens lets you compare data from different time periods, which helps to plot ideal curves rather than actual curves.

The following table describes fields in the Time area that pertain to historical pens.
## Historical Time Property Fields

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Apply Time to All Historical Pens</strong></td>
<td>Applies a common time period to all historical pens. When you select this option, you receive a message indicating that you are about to overwrite existing time properties for your historical pens.</td>
</tr>
<tr>
<td>Time Before Now</td>
<td>Specifies the number of days and hours before the current time to start the display. Select a value from the drop-down list or enter a value, in this format: &lt;br&gt; <code>dd:hh:mm:ss</code>&lt;br&gt; where the variables represent the number of days, hours, minutes, and seconds before the current time.</td>
</tr>
<tr>
<td>Fixed Start Time</td>
<td>Specifies a specific date and time on which to start the display. Enter a date and time, using this format: &lt;br&gt; `mm/dd/yy hh:mm:ss AM</td>
</tr>
<tr>
<td>Duration</td>
<td>The duration for the display, which determines how much data to display on the X axis. The minimum duration for a display is 1 second; the maximum is 99 days, 23 hours, 59 minutes, and 59 seconds. Using Proficy Historian, the minimum duration for a display is 1 second; the maximum is 999 days, 23 hours, 59 minutes, and 59 seconds. Enter a value in the following format: &lt;br&gt; <code>dd:hh:mm:ss</code></td>
</tr>
<tr>
<td>Interval</td>
<td>A time interval between the samples taken from the Historical Collect data file. The interval cannot be greater than half the Duration value. When the Span Interval is 0, the time interval between data samplings is determined automatically based on the span duration divided by the maximum number of display points. Enter a value in the following format: &lt;br&gt; <code>dd.hh:mm:ss</code></td>
</tr>
<tr>
<td>Display milliseconds</td>
<td>Allows you to enter milliseconds into the interval field. If you select this option, enter a value for the interval in the following format: &lt;br&gt; <code>dd.hh:mm:ss.ms</code></td>
</tr>
<tr>
<td>Time Zone:</td>
<td>The time zone to associate with the start time. You can select an explicit time zone, the client time zone, the server time zone, or the tag time zone. The default time zone is that of the client machine. This field is only available when Proficy Historian is being used.</td>
</tr>
</tbody>
</table>
Trending Historical Data

### Historical Time Property Fields

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjust for Daylight</td>
<td>Adjusts the time when the zone you selected is experiencing daylight saving if you selected the Automatically adjust clock for daylight saving changes check box in the Control Panel. This field is only available when Proficy Historian is being used.</td>
</tr>
</tbody>
</table>

### Setting Properties Related to Data Limits

Data limit properties control how data is presented by the selected pen. The default, Fetch Limits, automatically retrieves the low and high limits assigned to the data source. These assigned limits appear as dim values in the High limit and Low limit boxes.

To override the default values, clear the Fetch Limits check box and enter high and low limit values in the respective fields.

### Historical Mode Options

You use the Historical Mode options in conjunction with pens that display historical data. The display mode determines how iFIX selects data from an historical data source, displays it in the chart, and indicates what each displayed value represents.

The Historical Mode options are directly related to the Duration time property, as the duration determines the range of data used to calculate the data point plotted for the interval. The options in the Historical Mode drop-down list box are described in the following table.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample</td>
<td>The pen plots the last valid value, up to and including the start of the interval.</td>
</tr>
<tr>
<td>Avg</td>
<td>The pen plots the average of all valid data found during the interval, starting at the beginning of the interval, 12:00:00.</td>
</tr>
<tr>
<td>High</td>
<td>The pen plots the highest value found during the interval, starting at the beginning of the interval, 12:00:00.</td>
</tr>
<tr>
<td>Low</td>
<td>The pen plots the lowest value found during the interval, starting at the beginning of the interval, 12:00:00.</td>
</tr>
</tbody>
</table>
Applying Changed Pen Configurations to a Chart

You can use the Apply button in the Chart Group Configuration dialog box to apply the pen configurations displayed in the Pen List to the chart without associating a chart group file with the chart. The Apply button applies the pens to the chart and closes both the Chart Group Configuration dialog box and the Chart Group File dialog box, returning you directly to the WorkSpace in run mode.

To apply the current pen configurations without associating a chart group file with the chart, modify the current Pen List and click Apply.

A chart without an associated chart group file displays <no file> in the Chart Group File field of the Chart Group Configuration dialog box.

If you create a new chart group file and want to save the file as well as apply it to the selected chart, click the Save As button.

How the Chart Group Wizard Works in Configuration Mode

The Chart Group Wizard provides many charting options in configuration mode. You can use any of these three methods to create a chart group file:

- From inception.
- From an existing chart group configuration.
- From an existing chart group file.

You can use the Chart Group Wizard in configuration mode to:

- Apply the Chart Group Wizard to one or more charts in a picture to enable the operator to access the Wizard in run mode.
- Create, modify, save, and delete chart group files.
- Apply a default chart group file to a chart when a picture opens or on an object's Click event.

When you create a chart group file from an existing chart configuration, you can retain pen data sources that you know work for your process environment. The ability to extract existing pen configurations adds convenience when you implement the Chart Group Wizard in your iFIX configuration.

Applying the Chart Group Wizard to a Chart

You must use configuration mode to apply the Chart Group Wizard to one or more charts in your picture, or to remove it from one or more charts. If your picture contains multiple charts, you may want to apply the Chart Group Wizard to all or a subset of the charts in one operation.

When you apply the Chart Group Wizard to a chart, you can then invoke it when you double-click the chart in run mode. This enables you to use the Chart Group Wizard in run mode to:

- Select a chart group file to apply to the chart.
- Select a chart group file to apply pen configurations to the chart.
- Create and manage these chart group files.
Trending Historical Data

NOTE: If you apply the Chart Group Wizard to a chart, be sure to clear the Modifiable check box on the General tab of the Chart Configuration dialog box. By clearing this check box, the double-click event invokes the Chart Group Wizard in run mode, rather than the Chart Configuration dialog box.

NOTE: If you do not select a chart, the Chart Group Wizard displays a message reminding you to first select a chart before trying to apply or remove the Chart Group Wizard.

Considering When to Apply the Chart Group Wizard

You may want to consider which charts should have Chart Group Wizard functionality in run mode before applying the Chart Group Wizard to all the charts in your picture. You may not know the best pens to apply to a chart. The operator, who typically monitors the system, may have a better idea of what to track to find problems. You may consider giving the operator the opportunity to choose a chart group file to apply to a chart and the ability to modify and save chart group file configurations. If you want tighter control on what is monitored in your system, you can implement security options, which are described in Preventing Run-time Changes to Chart Group Files.

You may also want to add configuration properties to the chart that are only available through standard configuration, in the Chart Configuration dialog box. For more information, see Applying Chart Properties.

Determining if Chart Group Wizard is Applied to a Chart

Use either of these methods in configuration mode to determine if the Chart Group Wizard is applied to a chart:

- Expand the system tree for the chart object. If the Chart Group Wizard is applied to the chart, the variable string object, `FileName` exists.
- Edit the script for the chart object by selecting the chart object. Right-click and select Edit Script. A chart that has the Chart Group Wizard applied contains the following script for the Double-Click event:

  
  CGW_OpenChartGroupForm

To determine which charts have the Chart Group Wizard applied, double-click the chart in run mode. The charts that have the Wizard applied display in the Chart Group File dialog box.

---

**Configuring and Applying Chart Group Files**

The steps that follow explain how to configure and apply chart group files.

**To configure and apply chart group files:**

1. In Classic view, in the iFIX WorkSpace, click the Configure Chart Group Files button on the Chart Group toolbar.
   - Or-

   In Ribbon view, on the Tools tab, in the Charts group, click Chart Groups, and then click Configure Chart Group Wizard.

2. Define a pen configuration that you want to save and apply to charts.
3. In the Chart Group Configuration dialog box, click Save.
4. Enter a file name.
5. Click OK.
6. Configure as many chart group files as needed.
7. Insert a chart in a picture. Ensure that the chart is selected.

Applying a Chart Group File to a Chart

When you switch from configuration to run mode, a chart that has the Chart Group Wizard applied appears blank until you associate a chart group file with the chart. In some cases, the application developer may have already defined a default chart group file for the chart; in this case, the chart may automatically begin plotting data when you open the picture or when you click an object.

Use the following steps to apply the Chart Group Wizard to a chart in configuration mode, and then to apply a chart group file to the chart in run mode.

To apply a chart group file:

1. Select a chart to apply the Chart Group Wizard to.
2. In Classic view, in the iFIX WorkSpace, click the Apply Chart Group Wizard to Chart button on the Chart Group toolbar.
   -Or-
   In Ribbon view, on the Tools tab, in the Charts group, click Chart Groups, and then click Apply Chart Group Wizard to Chart.
3. Click the Apply Chart Group Wizard to Chart option.
4. Click OK. This applies the Chart Group Wizard to the selected chart.
5. Switch to run mode and double-click the chart. The Chart Group File dialog box appears.
6. Select one of the chart group files you created.
7. In the Chart Group File dialog box, click Apply. This applies the chart group file to the chart.

Creating and Managing Chart Group Files

You can create and manage chart group files from the Chart Group File dialog box, as indicated in the following table.

<table>
<thead>
<tr>
<th>Click</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Create a new chart group file.</td>
</tr>
<tr>
<td>Add Folder</td>
<td>Add a folder to the C:\Program Files\Proficy\Proficy iFIX\HTR directory.</td>
</tr>
</tbody>
</table>
Creating And Managing Chart Group File

<table>
<thead>
<tr>
<th>Click...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete File</td>
<td>Delete a selected chart group file.</td>
</tr>
<tr>
<td>Edit File</td>
<td>Modify an existing chart group file.</td>
</tr>
<tr>
<td>Save</td>
<td>Save a new or modified chart group file.</td>
</tr>
<tr>
<td>Save and Apply</td>
<td>Save a new or modified chart group file and apply it to the chart.</td>
</tr>
</tbody>
</table>

The New and Edit File button invokes the Chart Group Configuration dialog box, where you can add, modify, and delete pens. You cannot modify and save existing chart group files if the application developer set options in configuration mode that protect the files from any changes. Refer to Defining Pens in a Chart Group File for more information about defining pens.

Applying a Default Chart Group File to a Chart

A chart group file is typically not associated with a chart until the operator applies the chart group file in run mode. When you switch from configuration to run mode, a chart that has the Chart Group Wizard applied appears blank until you associate a chart group file with the chart. If the application developer has already defined a default chart group file for the chart, it may automatically begin plotting data when you open the picture or when you click an object.

However, you may want to assign a default chart group file to a chart in configuration mode, which is applied automatically in run mode. Assigning a chart group file ensures more control at run time. For example, as an application developer, you can remove Chart Group Wizard functionality from a chart and then assign a specific chart group file to the chart in run mode.

You can automatically apply a chart group file to a chart when:

- A picture opens.
- The operator clicks an object, including the chart itself

You can also let the operator make the chart and chart group selections at run time.

Displaying the Name of a Chart Group File

You may want to display the name of the chart group file associated with a chart to allow operators to determine which chart group file they applied.

To display the name of a chart group file without scripting:

1. Insert a chart in your picture and apply the Chart Group Wizard to it.
2. Insert a data link in your picture.
3. Enter the FileName variable object's InitialValue property as the data link's data source. For example, MyPicture.Chart1.FileName1.InitialValue.

4. Switch to run mode and apply a chart group file to the chart with the Chart Group Wizard. The name of the chart group file you applied appears in the data link.

To display the name of a chart group file with scripting:

1. Insert a chart in your picture and apply the Chart Group Wizard to it.
2. Insert a text object in your picture.
3. Position the cursor on the text object and click the right mouse.
4. Select Edit Script to register the text object in VBA.
5. Enter the following script below the CGW_OpenChartGroupForm on the chart's double click event:

   ```vba
   Text.Caption = FileNameX.InitialValue
   ```

   where Text is the name of your text object and X is the number of the FileName variable.

Preventing Run-time Changes to Chart Group Files

The Chart Group Wizard allows operators to configure chart group files in run time. However, for security reasons or to retain tighter control over process monitoring, you may want to limit which activities operators perform against chart group files in run mode.

Specifically, you can allow operators to apply a chart group file to a chart in run mode, but limit their ability to create a chart group file or modify and save existing chart group files.

Saving Chart Group Files

When you save a chart group file, you also save one or more pen configurations that you can apply in run mode to track different aspects of your process environment. The system file is saved in the C:\Program Files\Proficy\Proficy iFIX\HTR directory as a .CSV file. You have the option of saving the file in this directory or in a folder that you add to the directory. Use folders to organize your chart group files logically.

The Chart Group Wizard also lets you create and save multiple chart group files in one session of the Chart Group Configuration dialog box. When you click OK in the Chart Group File dialog box, the Chart Group Configuration dialog box reappears. You can continue to create, edit, and save chart group files before closing the dialog box.

How the Chart Group Wizard Works in Run Mode

The Chart Group Wizard gives operators the flexibility to apply different chart group files and pen configurations to charts. Depending on settings applied to a chart group file in configuration mode, operators may also create, modify and delete chart group files.

To apply chart group files to a chart in run mode, the chart must have the Chart Group Wizard applied to it in configure mode. Refer to Applying the Chart Group Wizard to a Chart to review how to create charts and define pens.
Double-click a chart with the Chart Group Wizard applied to it to access the Chart Group Wizard. The Chart Group File dialog box appears. You can select a chart group file to apply to a chart, and you can apply the pen configurations without actually associating the chart with a chart group file.

Depending on how the applications developer configured the Chart Group Wizard, you can also create, modify, save, and delete chart group files. These capabilities allow you to target and select only the data you must monitor with the freedom to apply and save different pen configurations.

---

**Using Scripting with the Chart Group Wizard**

This section shows how you can use one exposed method to apply a chart group file to a chart and how to use scripting with other exposed methods to perform various tasks, such as applying the Chart Group Wizard to a double-click event. A list of properties used by the Chart Group Wizard and a series of examples of using the Chart Group Wizard are also provided.

Refer to the following topics for more details:

- Applying a Chart Group File Through Scripting
- Applying the Chart Group Wizard Through Scripting
- Properties Defined Through the Chart Group Wizard

**Applying a Chart Group File Through Scripting**

The Chart Group Wizard lets you apply a chart group file to a chart through the following exposed method:

`CGW_ApplyFileToChart`

For example, you might include push buttons in your picture, where the Click event for each button applies a different chart group file to a chart. The demo picture, ChartGroupDemo, provides an example of this.

You can also apply a chart group file to any event of an object. For example, you can use the `CGW_ApplyFileToChart` method in a script for a rectangle's Mouse Down event. The Mouse Down event can apply a chart group file to a chart that plots the fill percentage of the rectangle and causes an alarm to sound when the value exceeds defined limits.

The following example shows code from the ChartGroupDemo picture for the first push button. This script uses the `CGW_ApplyFileToChart` subroutine to apply the ChartGroup1.csv file to the Chart2 object.

```vbscript
Private Sub CommandButton1_Click()

'Procedure: CommandButton1_Click()

'Purpose: To initialize the variable strHTCPath to the FIX 
'iFIX HTC Path, then Apply the Chart Group

'iFIX HTC Path, then Apply the Chart Group

'File "ChartGroup1.csv" to the Chart "Chart2"

Private Sub CommandButton1_Click()
```
Dim strMyChart As String
Dim strHTCPath As String

strHTCPath = System.FixPath(HTC_path)
strMyChart = strHTCPath & "\ChartGroup1.csv"

CGW_ApplyFileToChart strMyChart, "Chart2"
End Sub

### Applying the Chart Group Wizard Through Scripting

The Chart Group Wizard provides an exposed method that lets you apply the Chart Group Wizard to a chart through scripting. The following code example applies the Chart Group Wizard to the Double-click event of Chart1:

```vbnet
Private Sub Chart1_DblClick()
    CGW_OpenChartGroupForm
End Sub
```

The `CGW_OpenChartGroupForm` method opens the Chart Group File form. This method has an optional parameter for entering a chart name. If you want to apply a chart group file to a specific chart on an object's Click event, you can enter the following code on the object's Click event; in this example, the object is a command button:

```vbnet
Private Sub Commandbutton1_Click()
    CGW_OpenChartGroupForm "Chart1"
End Sub
```

### Properties Defined Through the Chart Group Wizard

The Chart Group Wizard reads pen data sources associated with existing charts and some pen properties, which it can save in a chart group file. The Chart Group Wizard saves only those properties defined through the Chart Group Wizard. These properties include pen styles, such as color and line style, data limits, and time-related properties, as listed in the following table.

<table>
<thead>
<tr>
<th>Time Properties</th>
<th>Data Properties</th>
<th>Pen Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>DaysBeforeNow</td>
<td>Data source</td>
<td>MarChar</td>
</tr>
<tr>
<td>Duration</td>
<td>HiLimit</td>
<td>MarkerStyle</td>
</tr>
</tbody>
</table>
Trending Historical Data

<table>
<thead>
<tr>
<th>Properties Defined Through The Chart Group Wizard</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time Properties</td>
</tr>
<tr>
<td>EndTime</td>
</tr>
<tr>
<td>FixedDate</td>
</tr>
<tr>
<td>StartTime</td>
</tr>
<tr>
<td>TimeBeforeNow</td>
</tr>
<tr>
<td>Data Properties</td>
</tr>
<tr>
<td>LoLimit</td>
</tr>
<tr>
<td>HistoricalSampleType</td>
</tr>
<tr>
<td>FetchPenLimits</td>
</tr>
<tr>
<td>Pen Properties</td>
</tr>
<tr>
<td>PenLineColor</td>
</tr>
<tr>
<td>PenLineWidth</td>
</tr>
</tbody>
</table>

You can configure properties for the chart that you cannot configure through the Chart Group Wizard. To configure these properties, double-click the chart to open the Chart Configuration dialog box. You can configure these chart properties:

- Properties on the General tab.
- Properties on the X-axis, Y-axis, Grid, and Legend tabs on the Chart tab.
- The Show Line, Constant Line, Show Gaps, and Maximum Display Points properties on the Pen tab of the Chart tab.

Refer to Applying the Chart Group Wizard Through Scripting for a sample script of toggling between the Chart Configuration dialog box and the dialog boxes invoked by the Chart Group Wizard.

Examples of Using the Chart Group Wizard

This section provides examples of how you can use the Chart Group Wizard to understand process trends in the iFIX environment. The examples show how you can:

- Apply the Chart Group Wizard to a chart to use in run mode.
- Modify a pen definition and save it in a chart group file.
- Modify a chart group file in run mode, and then apply and save the changes.
- Apply a chart group file to a chart on an object's Click event.
Each of these examples is based on the sample picture, ChartGroupDemo.grf, provided when you install iFIX.

**Example 1: Applying the Chart Group Wizard to a Chart**

The Chart Group Wizard is applied to Chart1 in the ChartGroupDemo.grf demo picture.

**To apply the Chart Group Wizard:**

1. Select Chart1 in configuration mode.
2. In Classic view, in the iFIX WorkSpace, click the Apply Chart Group Wizard to Chart button on the Chart Group toolbar.
   - Or -
   In Ribbon view, on the Tools tab, in the Charts group, click Chart Groups, and then click Apply Chart Group Wizard to Chart.
3. Select the Apply Chart Group Wizard option.
4. Click OK.

Refer to Applying the Chart Group Wizard to a Chart for more details.

**Example 2: Modifying a Pen Definition**

The ChartGroupDemo.grf demo picture uses three chart group files:

- ChartGroup1.csv
- ChartGroup2.csv
- ChartGroup3.csv

You can modify these files in either configuration or run mode. Click the Configure Chart Group Files button on the Chart Group toolbar (Classic view) or on the Tools tab, in the Chart Groups group, in the Chart Groups list, click Configure Chart Group Wizard (Ribbon view). The Chart Group Configuration dialog box appears, allowing you to create or modify chart group files.

To modify a chart group file in run mode, double-click Chart1, which has the Chart Group Wizard applied to it. The Chart Group File dialog box appears, allowing you to apply, create, or edit a file.

Modify chart group files and their pen configurations in the Chart Group Configuration dialog box, as shown in the following figure. In this example, the Marker Style for the second pen has been changed to Rectangle Marker. ChartGroup1.csv is the open file and the Marker Style for the second pen has been changed from a Rectangle to an Oval. Click Save to save your changes.

Select ChartGroup1.csv in the Chart Group File dialog box and click the Edit File button. The ChartGroup Configuration dialog box opens.
Modifying a Pen Definition

When you associate this chart group file with a chart in run mode, the marker style set here displays as a rectangle.

You can make many other changes in this dialog box, including adding and deleting pen definitions and saving the file under another name.

Example 3: Applying a Chart Group File in Run Mode

The Chart Group Wizard is applied to the ChartGroupDemo.grf demo picture. In run mode, Chart1 appears empty until you apply a chart group file to it. To apply a chart group file to a chart in run mode, double-click the chart. The Chart Group File dialog box appears. Click Apply, and then select a chart group file to apply to the chart.

The following figure shows the results of Chart1 when you apply a chart group file to it. When you
Example 4: Applying a Chart Group File on an Object's Click Event

The Chart Group Wizard is not applied to Chart2 in the ChartGroupDemo.grf demo picture. This is evident as the expanded System tree for the Chart2 object does not display the variable object FileName.

However, Command buttons, 1, 2, and 3 are configured to apply a chart group file to Chart2 based on their respective Click event. The Visual Basic script for each of these buttons uses the exposed Chart Group Wizard method, CGW_ApplyFileToCha, to automatically apply a file to a chart. Refer to Applying a Chart Group File Through Scripting for more information on automatically applying a file to a chart.

Before the chart can display detail, you must open the Chart Group Configuration dialog box, set the Marker Style to Oval Marker for the second pen listed in the ChartGroup2.csv file, and then switch to run mode.

Chart Group Wizard Dialog Boxes

The Chart Group Wizard includes the following dialog boxes (listed in alphabetical order):

- Apply Chart Group File Dialog Box
- Apply Chart Group Wizard Dialog Box
- Chart Group Configuration Dialog Box
- Chart Group File Dialog Box

Apply Chart Group File Dialog Box

The Apply Chart Group File dialog box displays the following items:
Trending Historical Data

Apply Chart Group File

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On Picture Open</td>
<td>Applies a chart group file to the selected chart when the picture opens in run mode. You can specify a chart group file or let the operator choose one in run mode.</td>
</tr>
<tr>
<td>On Click of Selected Object</td>
<td>Applies a chart group file to the selected chart when the operator clicks the selected object. You can specify a chart group file or the operator can choose one in run mode.</td>
</tr>
</tbody>
</table>

Chart

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Name</td>
<td>Enter the name of a chart on which to apply the chart group file when the picture opens or when the operator clicks a selected object. You can use the drop-down list box to view charts defined for the WorkSpace or the Browse button to browse for a chart.</td>
</tr>
<tr>
<td>Get Chart</td>
<td>Click this button if a chart is selected in the WorkSpace and you want to enter the name of that chart in the Chart Name text box.</td>
</tr>
<tr>
<td>Select Chart in Run</td>
<td>Check this box to enable the operator to select a chart to apply to a chart group file when the picture opens or to apply to an object's Click event.</td>
</tr>
</tbody>
</table>

Chart Group File

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Group File</td>
<td>Enter the name of the chart group file to apply to the selected chart. Click the Browse button to view a list of available chart group files.</td>
</tr>
<tr>
<td>Select Chart Group File in Run</td>
<td>Check this box to enable the operator to select the chart group file to apply to a chart when the picture opens or to apply to an object's Click event.</td>
</tr>
</tbody>
</table>

Remove

Removes the Chart Group File functionality from the selected chart.
**Apply Chart Group Wizard Dialog Box**

The Apply Chart Group Wizard dialog box displays the following items:

**Chart Name**
Displays the chart group file to apply to the chart.

**Apply Chart Group Wizard to Chart**
Applies Chart Group Wizard functionality to the selected chart.

**Remove Chart Group Wizard from Chart**
Removes Chart Group Wizard functionality from the selected chart.

**Chart Group Configuration Dialog Box**

The Chart Group Configuration dialog box displays the following items:

**Chart Group File**
Identifies the path and name of the chart group file currently associated with the chart. If no chart group file is associated with the chart, the label displays <no file>.

**Pen List**
Allows you to add a pen to the chart group by double clicking a blank field in the list; this allows you to select a data source for the pen.

**Time**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Apply Time to All Historical Pens</strong></td>
<td>Lets you apply common time properties to all historic pens in the Pen List.</td>
</tr>
<tr>
<td><strong>Time Before Now</strong></td>
<td>Specifies the number of days and hours before the current time to start the display. Select a value from the drop-down list or enter a value in this format: ddd:hh:mm:ss where the variables represent the number of days, hours, minutes, and seconds before the current time.</td>
</tr>
<tr>
<td><strong>Fixed Start Time</strong></td>
<td>Specifies whether to designate a specific date and time to start the display.</td>
</tr>
</tbody>
</table>
### Trending Historical Data

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| Duration              | Specifies the time duration for the chart. Enter a value in this format: dd:hh:mm:ss  
For historical pens, you can assign a time range to each pen or specify one global time period. Applying different time ranges to the pens lets you compare data from different time periods, which helps to plot ideal curves rather than actual curves. |
| Interval              | Allows you to set the interval.                                                                                                                                                                              |
| Display Milliseconds  | Specifies whether the application displays milliseconds.                                                                                                                                                     |
| Time Zone             | Allows you to specify the time zone.                                                                                                                                                                          |
| Adjust for Daylight Saving Time | Specifies if the application will automatically adjust for Daylight Saving Time.                                                                                                         |

### Pen Style

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| Line Style | Allows you to assign a style to the pen's plot line. You can apply these pen line styles:  
• Solid – solid.  
• Dashed – dashed.  
• Dot – dotted.  
• DashDot – dash-dot combination.  
• DashDotDot – dash-dot-dot combination. |
| Line Color | Applies a color to the pen's plot line.                                                                                                                                                                      |
| Line Width | Allows you to specify the width of a pen's plot line.                                                                                                                                                      |
### Using the Chart Group Wizard with Standard Charts

<table>
<thead>
<tr>
<th>Historical Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allows you to determine how iFIX selects data from an historical data source and displays it in a chart, and determines what each displayed value represents. The options are:</td>
<td></td>
</tr>
<tr>
<td>• Sample – The last valid value found is plotted, up to and including the start of the interval.</td>
<td></td>
</tr>
<tr>
<td>• Avg – The average of all valid data found during the interval is plotted, starting at the beginning of the interval, 12:00:00.</td>
<td></td>
</tr>
<tr>
<td>• High – The highest valid data point value found during the interval is plotted, starting at the beginning of the interval, 12:00:00.</td>
<td></td>
</tr>
<tr>
<td>• Low – The lowest valid data point value found during the interval is plotted, starting at the beginning of the interval, 12:00:00.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Marker Style</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allows you to specify a style for the pen's marker type. You can specify these types of pen markers:</td>
<td></td>
</tr>
<tr>
<td>• No Marker – no marker.</td>
<td></td>
</tr>
<tr>
<td>• Rectangle – rectangle marker.</td>
<td></td>
</tr>
<tr>
<td>• Oval – oval marker.</td>
<td></td>
</tr>
<tr>
<td>• Diamond – diamond marker</td>
<td></td>
</tr>
<tr>
<td>• Character - character marker, as designated in the Marker Character text box.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Marker Character</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applies the character you enter as the marker style for the line. You activate this dialog box by selecting Character from the Marker Style drop-down list box.</td>
<td></td>
</tr>
</tbody>
</table>

### Data

<table>
<thead>
<tr>
<th>Fetch Links</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specifies whether to automatically retrieve the low and high limits assigned to the selected data source.</td>
<td></td>
</tr>
</tbody>
</table>
### Trending Historical Data

<table>
<thead>
<tr>
<th>Low Limit</th>
<th>Allows you to enter the low limit value for the selected data source.</th>
</tr>
</thead>
<tbody>
<tr>
<td>High Limit</td>
<td>Allows you to enter the high limit value for the selected data source.</td>
</tr>
</tbody>
</table>

**Open File**

Lets you select a chart group file to modify or apply to a chart.

**New**

Click to clear the pens displayed in the Chart Group Configuration dialog Pen List and create a new chart group file.

**Save**

Click to save the current pen configurations. If a chart group file is already open, this saves the open file. If a chart group file is not open, this invokes the Chart Group File dialog box, where you can save the file under a new name or overwrite an existing file.

**Save As**

Click to invoke the Chart Group File dialog box, where you can save a new chart group file or overwrite an existing one.

**Apply Pens**

Closes this dialog box and applies your changes to the pen configurations on the chart.

**Chart Group File Dialog Box**

The Chart Group File Dialog Box displays the following items:

**Chart Group File Path**

Identifies the current path for the display of chart group files and folders.

**Chart Group File Tree**

Lets you select a chart group file or folder.
**Save As Read Only**

Check this box to save the chart group file as a read-only file. When you select this option, you can read, but you cannot modify the chart group file in run time.

**File Name**

Lets you enter a file name for a chart group.

**Add Folder**

Allows you to add a folder to the C:\Program Files\Proficy\Proficy iFIX\HTR folder for storing charts.

**Delete File**

Allows you to delete a chart group file.

---

**How Do I...**

The Chart Group Wizard help provides information for:

- Getting Started
- Working with Chart Group Files in Configuration Mode
- Working with the Chart Group Wizard in a Chart
- Working with Chart Group Files in Run Mode
- Defining Pens
- Using Scripts with the Chart Group Wizard

**Getting Started**

To get started with the Chart Group Wizard, refer to the following sections:

- Making the Chart Group Toolbar Visible
- Enabling the Local Node Alias
- Using the Chart Group Configuration Dialog Box
- Using the Chart Group File Dialog Box
- Using the Apply Chart Group File Dialog Box
- Using the Apply Chart Group Wizard Dialog Box

**Making the Chart Group Toolbar Visible**

**NOTE:** In Ribbon view, you can access the Chart Groups on the Tools tab, in the Charts
Trending Historical Data

1. In Classic view, in the iFIX WorkSpace menu, click Toolbars.
2. In the Owner list box, select Picture.
   
   **NOTE:** The Chart Group Toolbar is for use in pictures only.
3. Select the ChartGroup toolbar in the list of toolbars to make it visible.
   - Or -
   
   If it is not in the list of toolbars, click Customize to open the Customize Toolbars dialog box. Select the ChartGroupToolbar and select Import.
4. Select the ChartGroup toolbar in the list of toolbars and select Close.

Enabling the Local Node Alias Option

To enable the Local Node Alias option to use the ChartGroupDemo picture:

1. Ensure that you are logged in as an Administrator.
2. In Classic view, in the iFIX WorkSpace, click the System Configuration Utility button on the toolbar.
   - Or -
   
   In Ribbon view, on the Applications tab, in the System & Security group, click SCU.
3. On the Configure menu, click Local Startup.
4. Check the Local Node Alias box and click OK.
5. On the File menu, click Save.
6. Close the WorkSpace and restart iFIX. The SCU changes are now effective. Restart the SCU.

Using the Chart Group Configuration Dialog Box

What do you want to learn how to do?

**In Configuration Mode**

- Create chart group files from inception
- Create chart group files from an existing chart
- Create chart group files from an existing chart group file
- Save chart group files
- Modify chart group files

**In Run Mode**

- Create a chart group file
Using the Chart Group Wizard with Standard Charts

- Apply pen configurations to a chart
- Apply a chart group file to a chart
- Modify a chart group file
- Save a chart group file
- Save and apply a chart group file
- Delete a chart group file

Using the Chart Group File Dialog Box

What do you want to learn how to do?

In Configuration Mode
- Delete a chart group file
- Create a folder for storing chart group files

In Run Mode
- Apply a chart group file to a chart
- Create a chart group file
- Delete a chart group file
- Modify a chart group file
- Save a chart group file
- Save a chart group file and apply it to a chart
- Edit pens in a chart without applying a chart group file

Using the Apply Chart Group File Dialog Box

What do you want to learn how to do?
- Apply a file to a chart when a picture opens
- Apply a file to a chart on an object's Click event

Using the Apply Chart Group Wizard Dialog Box

What do you want to learn how to do?
- Apply Chart Group Wizard functionality to a chart
- Apply Chart Group Wizard functionality to multiple charts
- Remove Chart Group Wizard functionality from a chart
Trending Historical Data

Working with Chart Group Files in Configuration Mode

The following sections explain how to work with Chart Group Files in Configuration mode:

- Creating a Chart Group File from Inception
- Creating a Chart Group File from an Existing Chart Configuration
- Creating a Chart Group File from an Existing Chart Group File
- Saving a New Chart Group File
- Creating Folders for Storing Chart Group Files
- Applying a File When a Picture Opens
- Applying a File On an Object's Click Event
- Preventing Changes to Chart Group Files in Run Mode
- Using the Apply Chart Group File Dialog Box
-Deleting Chart Group Files
- Modifying a Chart Group File in Configuration Mode

Creating a Chart Group File from Scratch in Configuration Mode

To create a chart group file from scratch in configuration mode:

1. In Classic view, in the iFIX WorkSpace, click the Configure Chart Group Files button on the Chart Group toolbar.
   -Or-
   In Ribbon view, on the Tools tab, in the Charts group, click Chart Groups, and then click Configure Chart Group Wizard.

2. Add and configure pens.

3. Save the file.

Creating a Chart Group File from an Existing Chart in Configuration Mode

To create a chart group file from an existing chart in configuration mode:

1. Select the chart in configuration mode.

2. In Classic view, in the iFIX WorkSpace, click the Configure Chart Group Files button on the Chart Group toolbar.
   -Or-
   In Ribbon view, on the Tools tab, in the Charts group, click Chart Groups, and then click Configure Chart Group Wizard.

   The Chart Group Configuration dialog box appears, displaying the pens configured for the selected chart.
3. Add, modify, or delete the configured pens, if necessary.

4. Click Save As to save and name the file.

   NOTE: The Save As button is enabled only if you make a change to a pen in step 3.

Creating a Chart Group File from an Existing Chart Group File in Configuration Mode

To create a chart group file from an existing chart group file in Configuration mode:

1. In Classic view, in the iFIX WorkSpace, click the Configure Chart Group Files button on the Chart Group toolbar.

   -Or-

   In Ribbon view, on the Tools tab, in the Charts group, click Chart Groups, and then click Configure Chart Group Wizard.

2. In the Chart Group Configuration dialog box, click Open File.

3. In the Chart Group File dialog box, select a chart group file to open and click OK.

4. Add, modify, or delete pens in the existing chart group file.

5. Click Save As to save and name the file.

Saving a Chart Group File in Configuration Mode

To save a new chart group file in configuration mode:

1. In Classic view, in the iFIX WorkSpace menu, click the Configure Chart Group Files button.

   -Or-

   In Ribbon view, on the Tools tab, in the Chart Groups group, click Charts group, and then click Configure Chart Group Wizard.

2. Create new pen configurations, or click Open File to open an existing chart group file.

3. In the Chart Group Configuration dialog box, click Save As.

4. Optionally, click Add Folder to add a folder in the C:\Program Files\Proficy\Proficy iFIX\HTR folder. In the Chart Group File dialog box, enter a folder name.

5. In the File Name text box, enter a name for the chart group file, or select an existing folder and file to overwrite the contents of an existing file in the Chart Group File dialog box.

Creating Chart Group File Folders in Configuration Mode

To create a folder for storing chart group files in configuration mode:

1. In Classic view, the iFIX WorkSpace menu, click the Configure Chart Group Files button on the Chart Group toolbar.

   -Or-
In Ribbon view, on the Tools tab, in the Charts group, click Charts group, and then click Configure Chart Group Wizard.

2. In the Chart Group Configuration dialog box, click the Open File, Save, or Save As button.
3. In the Chart Group File dialog box, click Add Folder.
4. Enter the name of the folder you want to create.

   NOTE: You can add a subfolder to any folder in the chart group file tree. You cannot delete a folder from the chart group file tree. You must use Windows Explorer to delete a folder.

Applying a Default Chart Group File When a Picture Opens

To apply a default chart group file to a chart when a picture opens:

1. In configuration mode, in Classic view, click the Apply Chart Group File button on the Chart Group toolbar.
   - Or -

   In Ribbon view, on the Tools tab, in the Charts group, click Chart Groups, and then click Apply Chart Group File.

2. Select the Apply Chart Group File On Picture Open option.
3. Using the Chart area, enter a chart name in the text box, use the drop-down list box to select one, or click Get Chart to use the name of a chart already selected in the WorkSpace. Select the Select Chart in Run check box to select a chart in run mode.
4. Using the Chart Group File area, enter a chart group file name in the text box or use the Browse button to select one. Check the Select Chart Group File in Run check box to choose a chart group file to apply a chart in run mode.

Applying a Default Chart Group File on an Object's Click Event

To apply a default chart group file to a chart on an object's Click event:

1. In configuration mode, in Classic view, click the Apply Chart Group File button on the Chart Group toolbar.
   - Or -

   In Ribbon view, on the Tools tab, in the Charts group, click Chart Groups, and then click Apply Chart Group File.

2. Select the Apply Chart Group File On Click of Selected Object option.
3. Using the Chart area, enter a chart name in the text box, use the drop-down list box to select one, or click Get Chart to use the name of a chart already selected in the WorkSpace. Check the Select Chart in Run check box to select a chart in run mode.
4. Using the Chart Group File area, enter a chart group file name in the text box or use the Browse button to select one. Check the Select Chart Group File in Run check box to select a chart group file to apply to a chart in run mode.
Using the Chart Group Wizard with Standard Charts

Preventing Changes to a Chart Group File in Run Mode

To prevent changes to a chart group file in run mode:

1. In the iFIX WorkSpace, create or modify a chart group file.
2. From the Chart Group Configuration dialog box, click the Save or Save As button to save the chart group file.
3. From the Chart Group File dialog box's File Name text box, enter the name of the chart group file.
4. Check the Save As Read Only text box.
5. Click OK.

Deleting Chart Group Files in Configuration Mode

To delete a chart group file in configuration mode:

1. In Classic view, in the iFIX WorkSpace, click the Configure Chart Group Files button on the Chart Group toolbar.
   -Or-
   In Ribbon view, on the Tools tab, in the Charts group, click Chart Groups, and then click Configure Chart Group Wizard.
2. In the Chart Group Configuration dialog box, click the Open File, Save, or Save As button.
3. In the Chart Group File dialog box, select the chart group file that you want to delete.
4. Click Delete File. A message appears prompting you to delete the file.
5. Click OK.

Modifying a Chart Group File in Configuration Mode

To modify a chart group file in Configuration mode:

1. In Classic view, in the iFIX WorkSpace, click the Configure Chart Group Files button on the Chart Group toolbar.
   -Or-
   In Ribbon view, on the Tools tab, in the Charts group, click Chart Groups, and then click Configure Chart Group Wizard.
2. In the Chart Group Configuration dialog box, click Open File.
3. In the Chart Group File dialog box, select a file to edit and click OK.
4. Add, modify, and delete pen configurations in the Chart Group Configuration dialog box, as needed.
5. Click Save to save the changes.
Working with Chart Group Wizard in a Chart

For steps on how to work with the Chart Group Wizard functionality with a chart, refer to the following sections:

- Applying Chart Group Wizard Functionality to a Chart
- Applying Chart Group Wizard Functionality to Multiple Charts
- Removing Chart Group Wizard Functionality from a Chart

Applying Chart Group Wizard Functionality to a Chart

To apply Chart Group Wizard functionality to a chart:

1. In the iFIX WorkSpace, select a chart.
2. In Classic view, click the Apply Chart Group Wizard To Chart toolbar button.
   -Or-
   In Ribbon view, on the Tools tab, in the Charts group, click Chart Groups, and then click Apply Chart Group Wizard to Chart.
3. Select the Apply Chart Group Wizard To Chart option.
   The Apply Chart Group File dialog box appears when you double click the chart in run mode.

   NOTE: If you apply the Chart Group Wizard to a chart, you must clear the Modifiable check box on the General tab of the Chart Configuration dialog box. This ensures that the double-click event invokes the Chart Group Wizard, and not the Chart Configuration dialog box in run mode.

Applying Chart Group Wizard Functionality to Multiple Charts

To apply Chart Group Wizard functionality to multiple charts:

1. In the iFIX WorkSpace, select two or more charts.
2. Depress and hold the Ctrl button.
3. Click each chart to which you want to apply the Chart Group Wizard.
4. In Classic view, click the Apply Chart Group Wizard To Chart toolbar button.
   -Or-
   In Ribbon view, on the Tools tab, in the Charts group, click Chart Groups, and then click Apply Chart Group Wizard to Chart.
5. Select the Apply Chart Group Wizard To Chart option.

   NOTE: If you apply the Chart Group Wizard to a chart, you must clear the Modifiable check box on the General tab of the Chart Configuration dialog box. This ensures that the double-click event invokes the Chart Group Wizard, and not the Chart Configuration dialog box in run mode.
Removing Chart Group Wizard Functionality from a Chart

To remove Chart Group Wizard functionality from a chart:

1. In configuration mode, select the chart you want to remove Chart Group Wizard functionality from.
2. In Classic view, click the Apply Chart Group Wizard to Chart button on the Chart Group toolbar.
   - Or -
   In Ribbon view, on the Tools tab, in the Charts group, click Chart Groups, and then click Apply Chart Group Wizard to Chart.
3. Select the Remove Chart Group Wizard From Chart option.

Working with Chart Group Files in Run Mode

For steps on work with Chart Group Files in run mode, refer to the following sections:

- Applying a Chart Group File to a Chart
- Applying Pen Configurations to a Chart in Run Mode
- Creating a Chart Group File
- Modifying a Chart Group File
- Saving a Chart Group File
- Saving and Applying a Chart Group File
- Editing Chart Pens Without Applying a File
- Deleting a Chart Group File
- Using the Chart List Dialog Box

Applying a Chart Group File to a Chart in Run Mode

To apply a chart group file to a chart in run mode:

1. In the iFIX WorkSpace's run mode, double click a chart that has Chart Group functionality. The Chart Group File dialog box appears.
2. Select a chart group file.
3. Click Apply.

By default, the first chart group file in the list is selected. If the chart is already associated with a chart group file, that file is selected.
Applying Pen Configurations to a Chart in Run Mode

To apply a pen configuration to a chart in run mode:

1. In the iFIX WorkSpace's run mode, double click a chart that has Chart Group functionality. The Chart Group File dialog box appears.
2. Click New to create new pen configurations, or select a chart group file and click Edit File to apply pre-defined pen configurations.
3. From the Chart Group Configuration dialog box click the Apply Pens button, or from the Chart Group File dialog box click the Save & Apply button.

The pens you configure are applied to the chart and you are returned to the Chart Group File dialog box, the Chart Group File field is empty. There is no chart group file associated with the chart.

Creating a Chart Group File in Run Mode

To create a chart group file in run mode:

1. Double-click a chart that has Chart Group Wizard functionality. The Chart Group File dialog box appears.
2. Click New in the Chart Group File dialog box. The Chart Group Configuration dialog box appears
3. Add and configure pens.
4. Click Save As. The Chart Group File dialog box appears.
5. Enter a File Name and click Save to save and name the file.

Modifying a Chart Group File in Run Mode

To modify a chart group file in run mode:

1. Double-click a chart that has Chart Group functionality.
2. In the Chart Group File dialog box, select a file to edit and click Edit File.
3. In the Chart Group Configuration dialog box, add, delete, or modify the file's pen configurations as needed.
4. Click Save to save the changes. A message displays, asking if you want to overwrite the file.
5. Click Yes.
6. Click the New button to clear the Pen List to configure additional chart group files.
7. Enter new pen configurations, and click the Save As button.

Saving a Chart Group File in Run Mode

To save a chart group file in run mode:

1. Double-click a chart that has Chart Group functionality. The Chart Group File dialog box appears.
2. Click New to create a new chart group file or select a file to edit and click Edit File in the Chart Group File dialog box. The Chart Group Configuration dialog box appears.

3. In the Chart Group Configuration dialog box, add, delete, or modify the file's pen configurations as needed.

4. Click Save As to save and name the changes.

5. Select the appropriate folder and enter the name for the chart group file in the File Name field.

6. Click Save to save the file or click Save & Apply to save the file and apply it to the chart.

**Saving and Applying a Chart Group File in Run Mode**

To save and apply a chart group file in run mode:

1. Double-click a chart that has Chart Group functionality. The Chart Group File dialog box appears.

2. Click New to create a new chart group file, or in the Chart Group File dialog box select a file to edit and click Edit File. The Chart Group Configuration dialog box appears.

3. In the Chart Group Configuration dialog box, add, delete, or modify the file's pen configurations as needed.

4. Click Save to save the changes.

5. Select the appropriate folder and enter the name for the chart group file.

6. Click Save to save the file or click Save & Apply to save the file and apply it to the chart.

**Editing Pens in a Chart**

To edit pens in a chart:

1. Double-click a chart that has Chart Group functionality. The Chart Group File dialog box displays.

2. Click the Edit Pens button. The Chart Group Configuration dialog box appears.

3. Edit the pens in the pen list.

4. Click the Apply Pens button. The new pen configurations are applied to the chart; a chart group file is not applied to the chart.

**Deleting a Chart Group File in Run Mode**

To delete a chart group file in run mode:

1. Double click a chart that has Chart Group functionality.

2. In the Chart Group File dialog box, select a file to delete.

3. Click Delete File. The Chart Group Wizard displays a prompt to determine if you want to delete the file.
Trending Historical Data

Using the Chart List Dialog Box

To select a chart to apply a chart group file to using the Chart List dialog box:

1. Select one of the charts from the list. If a file displays in the File field, that file is applied to the chart you select. If the File field displays To be selected, you are prompted to select a file.

2. Click OK. If a chart group file displays in the File field, that file is applied to the chart you selected. Otherwise, the Chart Group File dialog box appears, allowing you to choose a file.

Defining Pens

In the Chart Group Wizard, you can perform the following pen tasks:

- Adding a Pen
- Deleting Pens
- Reordering Pens
- Defining Pen Properties

Adding Pens

To add a pen:

1. In Classic view, the iFIX WorkSpace, click the Configure Chart Group Files button on the Chart Group toolbar.
   - Or-
   In Ribbon view, on the Tools tab, in the Charts group, click Chart Groups, and then click Configure Chart Group Wizard.

2. From the Chart Group Configuration dialog box, double-click an empty line in the Pen List box and select a pen from the Pen List field.

3. Click the Browse button to the right of the Pen List field to open the Expression Builder.

4. In the Expression Builder, choose a data source for the pen. The pen can plot historical data or real-time data.

Deleting Pens

To delete a pen:

1. In Classic view, in the iFIX WorkSpace, click the Configure Chart Group Files button on the Chart Group toolbar.
   - Or-
   In Ribbon view, on the Tools tab, in the Chart Groups group, click Chart Groups, and then click Configure Chart Group Wizard.

2. From the Chart Group Configuration dialog box, in the Pen List, select a pen.
3. Click the X button from the Pen List toolbar. The X button is the second of four buttons.

Reordering Pens

To reorder pens in the Pen List:

1. In Classic view, in the iFIX WorkSpace, click the Configure Chart Group Files button on the Chart Group toolbar.
   -Or-
   In Ribbon view, on the Tools tab, in the Charts group, click Chart Groups, and then click Configure Chart Group Wizard.

2. From the Chart Group Configuration dialog box, select a pen.
3. Click the Up arrow in the Pen List toolbar to move the pen up in the list; click the Down arrow to move it down.

Defining Pen Properties

To define pen properties:

1. In Classic view, in the iFIX WorkSpace, click the Configure Chart Group Files button on the Chart Group toolbar.
   -Or-
   In Ribbon view, on the Tools tab, in the Charts group, click Chart Groups, and then click Configure Chart Group Wizard.

2. In the Chart Group Configuration dialog box, select a pen in the Pen List.
3. Optionally, enter the time duration for the chart in the Duration dialog box for a pen that plots real-time data.
   Optionally, check the Apply Time to All Historical Pens to assign common time properties for all historical pens for a pen that plots historical data. Set either the length of time before the present to start plotting data or set a fixed start date and time to plot data. In the Duration text box, enter a duration limit used by the Historical Mode to plot a data point for each time segment.

4. Optionally, enter data fetch limits for the pens and pen styles, such as line width, color, line type, and marker style.
4. Optionally, select an Historical sampling mode to use to plot data points for each time duration segment for historical pens.

Using Scripts with the Chart Group Wizard

The following sections describe how to use scripts with the Chart Group Wizard:

- Applying the Chart Group Wizard Functionality through Scripting
- Applying a Chart Group File through Scripting
Applying Chart Group Wizard Functionality Through Scripting

To apply Chart Group Wizard functionality to a chart through scripting:

Use the CGW_OpenChartGroupForm method, which you can access through script that lets you apply Chart Group Wizard functionality to a chart. The syntax for the method is:

```vbscript
CGW_OpenChartGroupForm
```

**Example**

1. Create a chart named MyChart.
2. Add the following script to the chart's double-click event:

   ```vbscript
   Private Sub Chart1_DblClick()
   CGW_OpenChartGroupForm
   End Sub
   ```

Applying a Chart Group File Through Scripting

To apply a chart group file to a chart through scripting:

Use the CGW_ApplyFileToChart method, which you can access through script that lets you apply a chart group file to a chart. The syntax for the method is:

```vbscript
CGW_ApplyFileToChart(strFileName As String, strChartName As String)
```

**Example**

1. Create a rectangle named MyRect.
2. Create a chart named MyChart.
3. Create a chart group file named chartgrouptest.csv.
4. Add the following script to the rectangle's double click event:

   ```vbscript
   Private Sub MyRect_DblClick()
   CGW_ApplyFileToChart "C:\Program Files\Proficy\Proficy iFIX\HTR\chartgrouptest.csv", "MyChart"
   End Sub
   ```

5. Enter the following syntax if you don't want to hard code the path:

   ```vbscript
   Dim path As String
   path = System.FixPath(Htc_Path)
   CGW_ApplyFileToChart path & "\chartgrouptest.csv", "MyChart"
   ```
## Index

### A

- Adding pens ...................................................... 73
- adjusting for daylight saving time .................... 67
- animating
  - chart properties ............................................. 61
  - animating .......................................................... 61
- Apply Chart Group File dialog ......................... 98
- applying
  - chart group configurations .......................... 102
  - chart group file ............................................. 84
  - chart group file in run mode ......................... 81
  - chart group file through scripting .................. 82
  - chart group file to a chart in run mode .......... 79
  - chart group files .......................................... 106
- Chart Group Wizard functionality ................... 106
- Chart Group Wizard through scripting ............. 83
- default chart group file ................................. 80
- applying ............................................................ 80
- applying pens to a chart .................................. 103

### C

- CGW_ApplyFileToChart method .................... 82
- CGW_OpenChartGroupForm method .............. 77
- Chart
  - applying Chart Group Wizard functionality ........ 106
- attributing a help context ID ......................... 51
- changing the appearance ................................ 53
- changing the refresh rate ............................... 55
- configuring the legend ................................... 61
- configuring the x and y axis ............................ 59
- defining a grid ................................................ 60
- defining a time range for each pen .................. 56
- defining pens ................................................ 46
- defining run-time attributes ......................... 62
- described .......................................................... 3
- displaying multiple times ............................. 63
- displaying multiple values ............................. 63
- displaying SQL data ....................................... 7
- displaying time cursors ................................... 64
- displaying tool tips ....................................... 64
- entering a description ................................... 51
- naming .......................................................... 50
- object ............................................................. 3
- plotting ideal curves ...................................... 51
- plotting real-time versus historical data .......... 6
- properties .......................................................... 45
- reading time .................................................. 65
- removing Chart Group Wizard functionality ....... 101
- retaining configured pens .............................. 96
Trending Historical Data

scrolling ........................................................ 51
specifying a scroll direction .......................... 51
transparent .................................................... 54
working in the run-time environment ........... 61
zooming ........................................................ 62
Chart ................................................................. 62
chart group configuration .................................. 102
chart group file ................................................. 81
chart group file, applying ............................... 77
Chart group file, applying ............................... 77
Chart Group Wizard about ................................................................. 69
applying through scripting ........................... 83
applying to charts ........................................ 106
before you begin ........................................... 70
configuring and applying .............................. 78
demonstration of using .................................... 84
fileName system tree string ........................... 77
functionality in run mode .............................. 81
removing from charts ...................................... 101
toolbar ........................................................... 69
Chart Group Wizard ......................................... 69
Chart Group Wizard methods
CGW_ApplyFileToChart ............................. 84
CGW_OpenChartGroupForm ....................... 77
Chart Group Wizard methods ........................... 77
Chart properties
animating ...................................................... 61
applying ........................................................ 45
applying to all pens ....................................... 45
defining ......................................................... 50
Chart properties .............................................. 50
ChartGroupDemo picture
using ............................................................. 94
ChartGroupDemo picture .................................. 94
Click event
applying chart group file ............................... 80
Click event ........................................................ 98
color, changing in a chart ................................. 54
Configuration mode  
  applying default chart group file ................... 80
Chart Group Wizard functionality ................ 77
Configuration mode .......................................... 77
configuring  
  pens ............................................................. 104
configuring ..................................................... 104
configuring and applying chart group files ....... 78
creating  
  chart group files ............................................ 97
  folders ........................................................... 97
creating ............................................................. 97
D  
Data limit properties ......................................... 74
data properties  
  defining for a pen.......................................... 46
data properties .................................................. 46
Data Sources ..................................................... 89
daylight saving time  
  adjusting for .................................................. 67
daylight saving time ......................................... 67
default chart group file ..................................... 98
defining  
  Chart grid ...................................................... 60
defining ............................................................. 60
deleting  
  pens ............................................................... 46
deleting ............................................................. 46
deleting chart group files .................................. 103
deleting pens ................................................... 104
demo picture  
  using ............................................................. 94
demo picture ..................................................... 94
display mode  
  choosing for a data source ............................. 46
display mode ..................................................... 46
Double-click event  
  applying Chart Group Wizard ....................... 83
Double-click event ............................................ 83
Duration property ............................................. 74
E  
editting pens ................................................... 103
Enhanced Charts ............................................. 3, 4
F  
Fetch Limit property ......................................... 74
FileName system tree string variable ................ 77
Fixed Start Time property .................................. 74
folder  
  adding ........................................................... 97
folder ............................................................. 97
G  
grid  
  defining for a chart ....................................... 60
grid ................................................................. 60
Trending Historical Data

H
Help context ID
attributing to charts........................................51
Help context ID .............................................51
historical data
plotting in a chart.........................................6
historical data ..............................................6
Historical mode property..................................76
Historical pen properties................................74
I
importing Chart Group toolbar ..........................93
L
Legend, configuring for a chart .........................61
Line color property .......................................74
Line style property .......................................74
Line width property .......................................74
Local Node Alias option ..................................94
Local Node Alias, enabling ..............................71
M
marker style
choosing for a pen .......................................55
marker style ..................................................55
Marker style property .....................................74
Methods
CGW_ApplyFileToChart .............................82
CGW_OpenChartGroupForm .......................77
Methods .....................................................77
Modifying
chart group files in Run mode .......................79
chart group files, preventing .......................81
pens .........................................................73
Modifying ...............................................73
modifying and applying a pen .......................77
modifying chart group files .........................99
P
ten
applying line styles ....................................55
ingoing a line color ......................................55
choosing a marker style for a chart ...............55
concepts ....................................................71
data limit-related properties .......................74
defining a data source for a chart .................46
defining a time range for a chart ..................56
defining for a chart ....................................46
defining styles for a chart ............................55
managing ....................................................73
modifying and applying .............................77
setting properties .......................................74
style properties ..........................................74
time-related properties ................................74
types .......................................................71
pen .........................................................71
pen configurations
applying ...................................................102
pen configurations ......................................102
pens .......................................................104
Index

Picture open event ............................................98
preventing runtime changes to chart group files .........................99

R
real-time data, plotting in a chart ........................................6
Real-time pen properties ..............................................74
refresh rate ..........................................................55
removing Chart Group Wizard functionality...........101
Reordering pens ..................................................73
Run mode
  applying chart group file ........................................81
  Chart Group Wizard functionality ..........................81
creating and managing chart group files .........................79
Run mode ..........................................................79
run-time environment
  defining attributes for a chart ..................................62
  viewing chart data ................................................61
run-time environment ..............................................61

S
saving
  chart group files ..............................................97
folders ..................................................................97
saving ...............................................................97
Saving chart group files
  in Configuration mode .........................................81
  in Run mode ......................................................79
Saving chart group files ............................................79
saving the chart group file ........................................81
scripting ................................................................106
security ..................................................................99
Selecting multiple charts ............................................77
SQL
  displaying data in a chart ....................................7
SQL ...................................................................7
Standard Charts ..................................................3, 4
T
Time Before Now property .......................................74
time range
  defining for each pen in a chart ...........................56
time range .............................................................56
toolbar
  Chart Group Wizard ............................................69
toolbar ....................................................................93
tooltips ....................................................................64
transparent chart ......................................................54
U
Universal Coordinate Time ......................................65
using Chart Group Wizard
  examples .............................................................84
using Chart Group Wizard ......................................84